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Setting Preferences
You can set preferences for the following items. 

Views
You can hide, show, and reorder items in the main and detailed views provided by the browser tool. You can also 
turn on and off the toolbar tips and menu hints.

Toolbar and status bar
You can show or hide the toolbar and status bar. You can also select and arrange the items to be included in the 
toolbar and status bar.

Objects
You can specify whether object deletions should require confirmation.

Alias objects
You can specify whether rights information displayed for Aliases should be taken from the original object or the 
Alias.

Tools
You can add or remove optional capabilities by installing or removing tools. This requires restarting NetWare* 
Administrator.

Registration
The syntax you use for the NetWare Administrator command line controls where your preferences are registered.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.





New Features
This release of NetWare* Administrator provides new features in the following areas:

             Administering multiple trees  
             Setting up user accounts  
             Editing properties of multiple users  
             Setting up print services  
             Managing desktop applications  
             Maintaining Directory databases  
             Migrating network files and objects  
             Accessing the internet  
             Customizing the user interface  

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.





Managing User Accounts
Setting Up New User Accounts
To set up a new user account, you need to create the object that represents the user, and then set up the default 
server, language, and working directories and files for the user. You can also set up optional accounting features. You
can use a Template object to facilitate these tasks. 

Automating Connections to Network Resources
Using login scripts you can automatically connect the user to the files, printers, and other network resources he or 
she needs. If several users use the same resources, you can put the script commands in container and Profile login 
scripts.

Editing User Properties
After creating users, if you need to update properties you can edit the associated property pages. You can edit 
property pages for several users at a time. 





Organizing and Browsing the Network
Using the Browser
When you start NetWare* Administrator, the browser tool is activated by default. The browser provides various 
administrative views of the network. This lets you organize, browse, and manipulate the network.

Organizing the Network
To organize the administrative view of your network, you create containers, which include Country, Organization, and 
Organizational Unit objects. For detailed guidelines on designing this view, see Chapter 3 in Guide to NetWare 4 
Networks.
You can also create Alias objects to provide access to the same object from several containers, and Computer 
objects to track extraneous network hardware.

Browsing Objects and Properties
Each browser window displays a single tree. Each tree lets you view the network objects that are stored in a single 
Directory. You can open multiple browser windows to view multiple trees. You can expand, collapse, print, and adjust 
the scope of each view.
You can also open property pages to edit the properties of individual objects.

Finding, Moving, and Renaming Objects
In the browser, you can move and rename objects. You can also search for objects based on specific property values.
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Getting Started
Purpose of NetWare Administrator
NetWare* Administrator lets you control the security and efficiency of your network by editing the contents and 
configuration of network Directories.

Using NetWare Administrator
NetWare Administrator is like a control console. It has a default set of controls known as the browser. Other sets of 
controls, known as tools, can be installed for specific purposes, such as to configure Directory database partitions 
and replication.
In the browser, you view each Directory as a tree that contains various network objects. You control access to 
network resources by assigning properties to these objects, and by creating logical groupings, roles, and so forth. 
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Managing File Services
Creating Objects for File System Resources
When a new NetWare 4* server is installed, objects are automatically created in the tree to represent the server and 
its volumes. This enables you to manage the file system from NetWare* Administrator. You can also manage 
NetWare 2 and 3 file systems if you create the necessary objects. 
To manage frequently used paths in the file system, you can create Directory Map objects. To record information 
about AppleTalk** services installed on NetWare servers, you can create AFP Server objects.
Managing Files and Directories
You can browse files and directories just as you do objects in NetWare Administrator. You can copy, move, and delete
files and directories, and create new directories. You can salvage or purge deleted files. You can also edit volume, 
file, and directory information, such as space limits, owners, and attributes.
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Implementing Security
Default Rights
NetWare* provides a basic level of network security through default rights. You can provide additional security by 
completing the tasks outlined below.

Assigning Rights
To ensure that users have the appropriate effective rights to resources, you can make explicit trustee assignments, 
grant security equivalences, and filter inherited rights.
To simplify the assignment of rights, you can create Group and Organizational Role objects, and then assign users to 
the groups and roles.
Adding Login Security
Login security is not provided by default. You can set up several optional login security measures, including login 
passwords, login location and time restrictions, limits on concurrent login sessions, intruder detection, and login 
disabling.

Setting File System Attributes
To control access to the NetWare file system, you can set file and directory attributes. Setting attributes is different 
than assigning file system rights, because the attributes of a file or directory are the same for all users, whereas the 
rights to a file or directory can be different for each user.
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Configure the Toolbar and Status Bar
Purpose
You can show, hide, or select the items to be included in the toolbar and status bar. 

Show the toolbar and status bar
On the View menu, check Show Toolbar and Show Status Bar.

Hide the toolbar and status bar
On the View menu, uncheck Show Toolbar and Show Status Bar.

Add, remove, or reorder buttons on the toolbar
1. Activate the tool for which you want to configure the toolbar. 
2. Right-click the toolbar and then choose Configure Toolbar and Status Bar.
3. On the Toolbar - Main Features tab, select and arrange the main toolbar buttons. 
4. On the Toolbar - View Features tab, select and arrange the view-specific toolbar buttons. 
5. On the Toolbar Location tab, select the desired location for the toolbar.
6. Choose OK.

Add, remove, or reorder information on the status bar

1. Activate the tool for which you want to configure the status bar. 
2. Right-click the status bar and then choose Configure Toolbar and Status Bar.
3. On the Status Bar tab, select and arrange the items of information to be included in the status bar.

4. Choose OK.



Filter and Reorder Browser Views
Purpose
You can show, hide, or reorder items in the tree and property-page views provided by the browser tool. This enables 
you to focus on the items that are of most interest to you. 

Show, hide, or reorder objects in a tree
1. Choose the window containing the tree, and then choose Sort and Include from the View menu.
2. On the Sort and Include by Object Class tab, select and arrange the classes of objects that you want shown.

3. Choose OK and then reexpand the containers in the tree.

Show, hide, or reorder property pages for a class of objects
1. Open the property pages (Details) for an object of the target class, and then choose Page Options.
2. On the Sort and Include Property Pages tab, select and arrange the property pages that you want shown.

3. Choose OK.
The changes affect the property pages of all the objects of that class.



Install and Remove Tools
Purpose
You can install and remove capabilities in NetWare* Administrator by installing and removing tools. To conserve 
memory, you should install only the tools that you need for your work. 

Install or remove a tool
1. Open the registry or file where your preferences are stored.

Your NetWare Administrator command-line syntax determines the location. If the preferences are stored in

A file, open the file with a text editor.
The Windows** 95** registry, run REGEDIT.EXE and open the following keys: 

HKEY_CURRENT_USER, Software, NetWare, Parameters, NetWare Administrator.
Your User object, right-click the object, choose Details, and then choose the NetWare Registry 

Database page.
2. Under Snapin View DLLs WIN3X and Snapin Object DLLs WIN3X, add or remove the entries for the desired 

tool.
If you are running Windows 95, the sections are called Snapin View DLLs WIN95 and Snapin Object DLLs 
WIN95.

3. Save your changes and then restart NetWare Administrator.
For information on the registration entries required for a tool, see the tool's help file. The help files are listed in the 
main table of contents of this help system. 
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Register Preferences
Purpose

You can control the registration of your preferences. 

Specify where your preferences are to be registered

Use the appropriate command-line syntax when starting NetWare* Administrator. 

Cause preference changes to be saved on exit

On the Options menu, check Save Settings On Exit.
If you uncheck this item, any preference changes you make during the current session won't be effective in the 
next session.
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Set Other Preferences
Purpose
You can turn on and off the toolbar tips and menu hints. You can also choose whether to be prompted for 
confirmation of object deletions, and whether rights information displayed for Alias objects should come from the 
original object or the Alias. 

Turn on toolbar tips and menu hints

On the View menu, check Show QuickTips and Show Hints.

Turn off toolbar tips and menu hints

On the View menu, uncheck Show QuickTips and Show Hints.

Get confirmation on object deletions

On the Options menu, check Confirm On Delete.

Cause rights information on Aliases to be taken from the original object

On the Options menu, check Get Aliased Object Trustees.

Cause rights information on Aliases to be taken from the Alias

On the Options menu, check Get Alias Trustees.





Create Template, User, and Profile Objects
Purpose
If you need to set up several new users who share certain requirements in common, you can create Template and 
Profile objects to facilitate the task. Typically, you complete the creation tasks in the order listed below.
To set up a user whose requirements are entirely unique, you don't need a Template or Profile. Just create the User 
object.

Create a Template
1. Right-click the container where you want to create the Template, and then choose Create.
2. In Class of new object, choose Template, and then choose OK.
3. In Name, type a name for the new object.

Make sure you follow standard object naming conventions.
4. (Optional) To base the Template on an existing Template or User, check Use template or user, and then choose 

the browse button to choose the Template or User. 
5. Choose Create.

Create a User
1. Right-click the container where you want to create the User, and then choose Create.
2. In Class of new object, choose User, and then choose OK.
3. In Login name, type a name for the new object.

This is the name the user will enter to log in. Make sure you follow standard object naming conventions.
4. In Last name, type the user's last name.
5. (Optional) Choose from the following options:

Use template
Create home directory
Define additional properties
Create another user

6. Choose Create.

Create a Profile
1. Right-click the container where you want to create the Profile, and then choose Create.
2. In Class of new object, choose Profile, and then choose OK.
3. In Name, type a name for the new object.

Make sure you follow standard object naming conventions.
4. Choose Create.



Set Up Account Resources
Purpose
Using a Template object, you can automate the setting up of the network environment for users, such as working 
directories and files. You can also set up accounting charges and balances if you need them. If you prefer, you can 
set up these resources manually, without using a Template.

Set up the network environment for a user
1. Choose a Template if you haven't created the User object yet. Otherwise, choose the User.
2. From the Object menu, choose Details, and then choose the Environment page.
3. Fill in the following fields:

Language
Default server
Home directory

4. Perform any other needed setup tasks, such as copying files to the home directory.

If you are using a Template:

a. Check Run setup and enter the commands to perform the tasks in Setup script. 
b. Choose OK.
c. Create the user based on the Template.

If you aren't using a Template:
a. Choose OK.
b. Perform the needed tasks "manually" (outside of NetWare* Administrator).

Set up accounting charges on a server
1. Right-click the NetWare Server object, choose Details, and then choose Accounting.

If you are prompted to install accounting, choose Yes. If you are prompted to remove accounting, choose No.
2. Choose the property page for the service that you want to charge for: Blocks Read, Blocks Written, Connect 

Time, Disk Storage, or Service Requests.
If you aren't sure what a particular service means, choose its property page and then choose Help.

3. Define the charge rates for the service. 
4. Repeat Steps 2 and 3 for each service that you want to charge for, and then choose OK.
You should set up accounting on each server that you want the user to be charged for using.

Set the account balance for a user
1. Choose a Template if you haven't created the User yet. Otherwise, choose the User.
2. From the Object menu, choose Details, and then choose the Account Balance page.

3. Fill in Account balance. 
4. (Optional) To enforce a credit limit, uncheck Allow unlimited credit and fill in Low balance limit.
5. Choose OK.
If you used a Template, create the User based on the Template.
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Work with Login Scripts
Purpose
In NetWare* Administrator, you create login scripts as properties of container, Template, Profile, or User objects.
You can also create login scripts as text files using a text editor. However, such login scripts can only be used as 
substitutions for the Profile or User login script. (The user specifies the path and filename when running the login 
utility.)

Edit a login script
1. Right-click the container, Template, Profile, or User whose login script you want to edit, and then choose Details.

2. On the Login Script page, enter the login script commands. 
3. Choose OK.
If the Directory database needs to synchronize the changes, it might take a few minutes before the user can log in 
with the new login script.

Associate a Profile login script with a user
1. Right-click the user, and then choose Details.
2. On the Login Script page, choose the browse button to the right of Profile.
3. Choose the Profile you want to associate with the user, and then choose OK.
4. Choose OK.
5. Right-click the Profile, and then choose Trustees of this Object.
6. Choose Add Trustee, choose the user, and then choose OK.
7. Under Object rights, check Browse.
8. Under Property rights, make sure Read is checked, either for all properties or for the Login Script property.
9. Choose OK.
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Edit Multiple Users Simultaneously
Purpose

Use this procedure if you need to edit properties for several users at the same time. 

Edit properties of multiple users simultaneously
1. Choose the User objects whose properties you want to edit.

To choose the Users, hold down Ctrl or Shift and click any combination of Users, containers, Groups, and 
Templates.

2. From the Object menu, choose Details on Multiple Users.

3. Edit the property pages. 
For help with individual properties, choose Help.

4. (Optional) To modify the list of users to which your changes will be applied, choose User List, edit the list, and 
then choose OK.

5. To apply your changes, choose OK.
You are prompted to confirm the operation, and you are given the option to pause if errors occur during the 
operation. If you choose not to pause on errors, you can view and save any errors when the operation is done.





Create Group and Organizational Role Objects
Purpose
To simplify the assignment of rights, you can create Group and Organizational Role objects, and then assign users to 
the groups and roles.

Create a Group
1. Right-click the container where you want to create the Group, and then choose Create.
2. In Class of new object, choose Group, and then choose OK.
3. In Group name, type a name for the new object.

Make sure you follow standard object naming conventions.
4. Check Define additional properties, and then choose Create.
5. On the Members page, add the users that you want to be members of the group, and then choose OK.
6. Assign the rights that you want the group to have.

Create an Organizational Role
1. Right-click the container where you want to create the Organizational Role, and then choose Create.
2. In Class of new object, choose Organizational Role, and then choose OK.
3. In Organizational role name, type a name for the new object.

Make sure you follow standard object naming conventions.
4. Check Define additional properties, and then choose Create.
5. On the Identification page, in Occupant, add the complete names of the users who you want to be occupants of 

the role, and then choose OK.
6. Assign the rights that you want the organizational role to have.



Assign Rights
Purpose
To ensure that users have the appropriate effective rights to resources, you can make explicit trustee assignments, 
grant security equivalences, and filter inherited rights.

Grant a user rights to objects
1. Right-click the User, Group, or Organizational Role object that you want to grant rights to, and then choose 

Rights to Other Objects.

2. Edit the list of rights assignments, and then choose OK. 

Grant a user rights to files and directories
1. Right-click the User, Group, or Organizational Role object that you want to grant rights to, choose Details, and 

then choose the Rights to Files and Directories page.

2. Edit the list of rights assignments, and then choose OK. 

Grant a user security equivalence to objects
1. Right-click the User that you want to grant security equivalences for, choose Details, and then choose the 

Security Equivalences page.
2. Use Add and Delete to edit the list of objects that the user has security equivalence to, and then choose OK.

Assign trustees for an object
1. Right-click the object that you want to assign trustees for, and then choose Trustees of this Object.

2. Edit the list of trustees, and then choose OK. 

Assign trustees for a file or directory
1. Right-click the file or directory that you want to assign trustees for, choose Details, and then choose the Trustees

of this File/Directory page.

2. Edit the list of trustees, and then choose OK. 

Block inherited rights to an object
1. Right-click the object that you want to block rights to, choose Trustees of this Object, and then choose Inherited

Rights Filter.
2. Uncheck the check boxes for the rights that you want blocked, and then choose OK.

Block inherited rights to a file or directory
1. Right-click the file or directory that you want to block rights to, choose Details, and then choose the Trustees of 

this File/Directory page.
2. Under Inheritance filter, uncheck the check boxes for the rights that you want blocked, and then choose OK.



Implement Login Security
Purpose
Login security is not provided by default. You can set up several optional login security measures, including login 
passwords, login location and time restrictions, limits on concurrent login sessions, intruder detection, and login 
disabling.

Set up login security for a user
1. Right-click the User object, and then choose Details.
2. (Optional) On the Login Restrictions page, limit the number of login sessions the user can have open at a time.
3. (Optional) On the Password Restrictions page, choose the password security features you want.
4. (Optional) On the Login Time Restrictions page, restrict the times of the day when the user can be logged in.

5. (Optional) On the Network Address Restrictions page, restrict the locations (network addresses) the user 
can log in from. 
6. Choose OK.

Set up intruder detection for the users in a container
1. Right-click the container, and then choose Details.
2. Fill in the Intruder Detection page, and then choose OK.

Disable or enable a user account
1. Right-click the User, choose Details, and then choose the Login Restrictions page.
2. Check or uncheck Account disabled, and then choose OK.



Set File System Attributes
Purpose
To control access to the NetWare* file system, you can set file and directory attributes. Setting attributes is different 
than assigning file system rights, because the attributes of a file or directory are the same for all users, whereas the 
rights to a file or directory can be different for each user.

Set attributes for a file or directory
1. Right-click the file or directory that you want to set attributes for, choose Details, and then choose the Attributes 

page.
2. Check and uncheck the check boxes for the attributes that you want to set and clear, and then choose OK.
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Create Container, Alias, and Computer Objects
Purpose
To organize the administrative view of your network, you create containers, which include Country, Organization, and 
Organizational Unit objects. For detailed guidelines on designing this view, see Chapter 3 in Guide to NetWare 4 
Networks.
You can also create Alias objects to provide access to the same object from several containers, and Computer 
objects to track extraneous network hardware.

Create a Country
1. Right-click the root object in the tree, and then choose Create.
2. In Class of new object, choose Country, and then choose OK.
3. In Country name, type a name for the new object.

Make sure you follow the Country naming conventions.
4. Choose Create.

Create an Organization
1. Right-click the Root or Country object where you want to create the Organization, and then choose Create.
2. In Class of new object, choose Organization, and then choose OK.
3. In Organization name, type a name for the new object.

Make sure you follow standard object naming conventions.
4. Choose Create.

Create an Organizational Unit
1. Right-click the Organization where you want to create the Organizational Unit, and then choose Create.
2. In Class of new object, choose Organizational Unit, and then choose OK.
3. In Organizational unit name, type a name for the new object.

Make sure you follow standard object naming conventions.
4. Choose Create.

Create an Alias
1. Right-click the container where you want to create the alias, and then choose Create.
2. In Class of new object, choose Alias, and then choose OK.
3. In Alias name, type a name for the new object.

Make sure you follow standard object naming conventions.
4. Fill in Aliased object.
5. Choose Create.

Create a Computer
1. Right-click the container where you want to create the Computer, and then choose Create.
2. In Class of new object, choose Computer, and then choose OK.
3. In Computer name, type a name for the new object.

Make sure you follow standard object naming conventions.
4. Choose Create.



Browse Objects and Properties
Purpose
Each browser window displays a single tree. Each tree lets you view the network objects that are stored in a single 
Directory. You can open multiple browser windows to view multiple trees. You can expand, collapse, print, and adjust 
the scope of each view.
You can also open property pages to edit the properties of individual objects.

Open a new tree
1. From the Tools menu, choose NDS Browser.
2. In Tree, type or choose the tree you want, or choose the tree button to choose from the available trees.
3. In Context, type or choose the complete name of the container or Volume object that you want to place at the top 

of the view, or choose the browse button to choose from the available containers and volumes.
4. Choose OK.

Open a duplicate of the current browser window

From the Window menu, choose New Window.

Open property pages for an object

Right-click the object, and then choose Details.

You can browse and edit the property pages if you have the necessary rights. 

Open a new container or file system view

From the current browser window, right-click the container or Volume you want to view, and then 
choose Browse.

A new browser window appears with the selected container or Volume at the top.

Adjust the scope of a browser window

To adjust the scope of the current browser window up one level in the tree, press Backspace.
To set the top object in the current browser window, double-click the tree name in the status bar. 

Then, in Context, choose the object you want and choose OK.
To expand or collapse a container or Volume, double-click it.

Print a browser window
1. Click the browser window you want to print.
2. From the Object menu, choose Print, and then choose OK.

In the Print dialog box, you can change the format, print quality, and print device used for the output. For details, 
choose Help.



Find, Move, and Rename Objects
Purpose
In the browser, you can move and rename objects. You can also search for objects based on specific property 
values.

Go to an object

Begin typing the object's name. Press Enter when the object appears.

Search for objects by property
1. Choose the container you want to start the search from.
2. From the Object menu, choose Search.
3. Choose from the following options:

Search entire subtree
Search for
Property
Save
Open

4. Choose OK.
The matching objects are displayed in a new browser window. You can work in the new window just as you do in 
any browser window.

Move objects
1. Browse to the objects you want to move.
2. Browse to the destination container.

The destination can be in another browser window that contains the same tree or a different tree. You might need 
to tile the windows so that both the source and destination are visible.

3. Choose the objects you want to move.
To choose multiple items, hold down Ctrl or Shift while clicking.

4. Drag and drop the objects onto the destination container.
5. In the dialog box that appears, choose OK.

Rename an object
1. Choose the object.
2. From the Object menu, choose Rename.
3. In New name, type a new name for the object.

Make sure you follow standard object naming conventions.
4. Choose from the following options:

Save old name
Create alias in place of renamed container

5. Choose OK.



Create Server, Volume, and Directory Map Objects
Purpose
When a new NetWare 4* server is installed, objects are automatically created in the tree to represent the server and 
its volumes. This enables you to manage the file system from NetWare* Administrator. You can also manage 
NetWare 2 and 3 file systems if you create the necessary objects. 
To manage frequently used paths in the file system, you can create Directory Map objects. To record information 
about AppleTalk** services installed on NetWare servers, you can create AFP Server objects.

Create a NetWare Server
1. Right-click the container where you want to create the NetWare Server, and then choose Create.
2. In Class of new object, choose NetWare Server, and then choose OK.
3. In NetWare server name, type a name for the new object.

Make sure you understand the NetWare server naming conventions.
4. Choose Create.

Create a Volume
1. Right-click the container where you want to create the Volume, and then choose Create.
2. In Class of new object, choose Volume, and then choose OK.
3. In Volume name, type a name for the new object.

Make sure you follow standard object naming conventions.
4. Fill in Host server.
5. In Physical volume, choose the volume that the new object will represent.
6. Choose Create.

Create a Directory Map
1. Right-click the container where you want to create the Directory Map, and then choose Create.
2. In Class of new object, choose Directory Map, and then choose OK.
3. In Directory map name, type a name for the new object.

Make sure you follow standard object naming conventions.
4. Choose the browse button between Volume and Path. Then, from the selection dialog box, choose the directory 

that the new object will represent and choose OK.
5. Choose Create.

Create an AFP Server
1. Right-click the container where you want to create the AFP Server, and then choose Create.
2. In Class of new object, choose AFP Server, and then choose OK.
3. In AFP server name, type a name for the new object.

Make sure you follow standard object naming conventions.
4. Choose Create.
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Manage Files and Directories
Purpose
You can browse files and directories just as you do objects in NetWare* Administrator. You can copy, move, and 
delete files and directories, and create new directories. You can salvage or purge deleted files. You can also edit 
volume, file, and directory information, such as space limits, owners, and attributes.

Browse files and directories
1. Double-click the Volume object that contains the files and directories.

If the Volume doesn't exist in a tree, create it.
2. Continue double-clicking directories to expand or collapse branches of the file system.

Double-clicking a file opens information about the file; it doesn't open the file itself.

Copy or move files and directories
1. Browse to the files and directories that you want to copy or move.
2. Browse to the destination volume or directory.

The destination can be in another browser window that contains the same tree or a different tree. You might need 
to tile the windows so that both the source and destination are visible.

3. Choose the files and directories that you want to copy or move.
To choose multiple items, hold down Ctrl or Shift while clicking.

4. Drag and drop the files and directories onto the destination.
5. In the dialog box that appears, choose Move or Copy, and then choose OK.

Create a directory
1. Right-click the Volume or directory that you want to create the new directory in, and then choose Create.
2. Fill in Directory name.
3. Choose Create.

Salvage or purge deleted files
1. Choose the directory that the files were deleted from.

If the directory was deleted, choose any directory on the volume.
2. From the Tools menu, choose Salvage.
3. From the list of deleted files, choose the files that you want to salvage or purge, and then choose Salvage or 

Purge. 
4. Choose Close.

Edit file or directory information
1. Right-click the Volume, file, or directory whose information you want to edit, and then choose Details.

2. Edit the property pages. 
3. Choose OK.
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Sort and Include by Object Class
Purpose
This tab lets you select and arrange the classes of objects to be shown in the current browser window. This enables 
you to focus on the items that are of most interest to you in the tree. 

Options
Included classes
Available classes

    

    



Sort and Include Property Pages
Purpose
This tab lets you select and arrange the property pages to be shown for the current class of objects. This enables you
to focus on the properties that are of most interest to you when viewing any object of the class. 

Options
Active pages
Available pages

    

    



Status Bar
Purpose
This tab lets you select and arrange the items of information to be shown in the status bar. The set of available items 
depends on which tool is currently providing the main view. 

Options
Active items
Available items
Show status bar

    

    



Toolbar - Main Features
Purpose
This tab lets you select and arrange the main buttons to be included in the toolbar. 

Options

Active buttons 
Available buttons
Show toolbar

    

    

    



Toolbar - View Features
Purpose
This tab lets you select and arrange the view-specific buttons to be included in the toolbar. 

Options
Active buttons
Available buttons
Show toolbar

    

    

    



Toolbar Location
Purpose
This tab lets you position the toolbar.

Options
Choose Top, Left, Bottom, or Right.





New Object
Purpose
This dialog box lets you choose the class of object to create.

Options
Parent
Class of new object
Context



Create User
Purpose
This dialog box lets you create User objects. You can base the new Users on a template if desired.

Options
Login name
Last name
Use template
Create home directory
Path
Home directory
Define additional properties
Create another user



Select New Home Directory Path
Purpose
This dialog box lets you specify a different location and name for the home directory, either because the currently 
specified location doesn't exist in the file system, or because the currently specified name is already used by an 
existing directory in the file system.

Options
Path
Home directory



Create User - Synchronization Delay
Purpose
This status box appears if the current file-system operation is waiting for a previous User-creation operation to finish 
synchronizing in the Directory database. The line below the initial paragraph specifies which file-system operation is 
pending.

Options
You can wait for the status box to disappear, indicating that the previous User-creation operation finished 

synchronizing.
Choose Skip to skip the pending operation and proceed with the next operation.
Choose Stop to skip all remaining operations.

Note: If the User is being created in a master replica that resides across a WAN link, synchronization could take a 
long time. If you skip any pending operations, at the end of the User-creation process you are given the option to log 
them. You can complete them yourself later.



Create Template
Purpose
This dialog box lets you create Template objects.

Options
Name
Use template or user 

Define additional properties
Create another template



Identification
Purpose
This property page lets you provide optional information that can facilitate searching for the User object. 

Options
Other name
Title
Description
Location
Department
Telephone
Fax number



Add or Delete Property Values
To add a value, choose Add, type in the value, and press Enter.

Use the syntax that is required for the property. Each new entry appears at the bottom of the list. To get the 
entries into a particular order, you might need to delete them all and then add them back in the desired order.

To delete a value, select it from the list and choose Delete.
If the property is multivalued, each entry in the list constitutes a separate property value. If the property is single-
valued, the entire list constitutes the single property value. For some single-valued properties, such as Language, the
order of the entries is significant.



Environment
Purpose
This property page lets you set up the network environment, such as working directories and files, for the user.

Options
Language
Default server
Home directory
Run setup
Setup script



Login Restrictions
Purpose
This property page lets you enable, disable, or set an expiration date for the user account. You can also limit the 
number of login sessions the user can have open at a time. 

Options
Account disabled 

Account has expiration date
Limit concurrent connections
Maximum connections



Password Restrictions
Purpose
This property page lets you implement login password security for the user. 

Options
Allow user to change password
Require a password
Minimum password length
Force periodic password changes
Days between forced changes
Date password expires
Require unique passwords
Limit grace logins
Grace logins allowed
Set password after create





Error Log
Purpose
This dialog box appears if there were errors modifying the User objects but you chose not to pause on each 
occurrence.

Options
Choose Save As if you want to save the error log as a text file before closing this dialog box.
Choose Close to close this dialog box.
To look up an error message or code, go to the main table of contents of this help system and choose 

System Messages.



Group Membership
Purpose
This property page lets you make the user a member of one or more groups. This makes it easier for you to assign 
rights to the user. 

Options
Memberships 

Add
Delete



Login Script
Purpose
This property page lets you create or edit a login script for the user. You can also assign a Profile object to the user.

Options
Login script 

Profile



Login Script
Purpose
This property page lets you create or edit a login script for the users associated with this container or Profile object.

Options
Login script



Volume Space Restrictions
Purpose
This property page lets you limit the disk space the user can use on one or more volumes. This is optional, but it can 
be helpful if storage resources are limited. 

Options
Volume list 

Add
Modify
Delete



Set Volume Space Limit
Purpose
This dialog box lets you set the user's space restriction on the volume.

Options
Volume
Space limit



Modify Volume Space Limit
Purpose
This dialog box lets you change the user's space restriction on the volume.

Options
Volume
Space limit



Account Balance
Purpose
This property page lets you set and monitor an accounting balance for the user. You can also cause the user account 
to be locked if the balance falls below a specified value. 

Options
Account balance 

Allow unlimited credit 
Low balance limit



Postal Address
Purpose
This property page lets you specify optional postal information for the user. The information is for reference only, 
although it can also facilitate searching for the User object. 

Options
Street
Post office box
City
State or province
Postal (Zip) code
Mailing label information
Copy to Label



Members of Template
Purpose
This property page lists the User objects that have been created from this template. The list is used by the Details on
Multiple Users command to determine which Users are associated with the template. You can add and delete 
members of the list. 

Options
Members of Template
Add
Delete



See Also
Purpose
This property page lets you list other objects that are related to this object. The list has no functional purpose; it is for 
reference only. 

Options
See Also 

Add
Delete



Identification
Purpose
This property page lets you provide optional information that can facilitate searching for the User object. 

Options
Login name
Given name
Last name
Full name
Generational qualifier
Middle initial
Other name
Title
Description
Location
Department
Telephone
Fax number



Environment
Purpose
This property page lets you assign properties related to the user's network environment, such as a default server and 
a home directory. Most of the properties are optional. 

Options
Language
Network address
Default server
Home directory



Objects Selected for Multiple User Details
Purpose
This dialog box lists the User objects that your changes will be applied to.

Options
Choose Add to include another user in the list.
Choose Remove to exclude the selected user from the list.



Identification
Purpose
This property page lets you assign additional property values that can facilitate searching for the User objects. 

Options
Other name 

Title
Description
Location
Department
Telephone
Fax number



Environment
Purpose
This property page lets you edit properties related to the users' network environment, such as the default server and 
the home directory. 

Options
Language 

Default server
Home directory



Postal Address
Purpose
This property page lets you edit optional postal information for the users. The information is for reference only, 
although it can also facilitate searching for the User objects. 

Options
Street
Post office box
City
State or province
Postal (zip) code



Create Profile
Purpose
This dialog box lets you create Profile objects.

Options
Profile name
Define additional properties
Create another profile



Identification
Purpose
This property page lets you provide optional information that can facilitate searching for the Profile object. 

Options
Name
Other name
Description
Location
Department
Organization



Blocks Read
Purpose
This property page lets you set charge rates for disk blocks read by this server. Do this only if you need to implement 
accounting for one or more users. 

Options
Time grid
Reset
Charge rate list 

Add Charge Rate
Delete Charge Rate
Accounting



Blocks Written
Purpose
This property page lets you set charge rates for disk blocks written by this server. Do this only if you need to 
implement accounting for one or more users. 

Options
Time grid
Reset
Charge rate list 

Add Charge Rate
Delete Charge Rate
Accounting



Connect Time
Purpose
This property page lets you set charge rates for time (in minutes) connected to this server. Do this only if you need to 
implement accounting for one or more users. 

Options
Time grid
Reset
Charge rate list 

Add Charge Rate
Delete Charge Rate
Accounting



Disk Storage
Purpose
This property page lets you set charge rates for blocks of disk space used on this server. Do this only if you need to 
implement accounting for one or more users. 

Options
Time grid
Reset
Charge rate list 

Add Charge Rate
Delete Charge Rate
Accounting



Service Requests
Purpose
This property page lets you set charge rates for service requests made to this server. Do this only if you need to 
implement accounting for one or more users. 

Options
Time grid
Reset
Charge rate list 

Add Charge Rate
Delete Charge Rate
Accounting



Add Charge Rate
Purpose
This dialog box lets you add a charge rate to the list.

Options
In Multiplier, enter the top part of the fraction. This is the number that is subtracted from the user's account 

balance for each unit of service.
In Divisor, enter the bottom part of the fraction. This is the number that defines the unit of service.



Create NetWare Server
Purpose
This dialog box lets you create new NetWare* Server objects. 

Options
NetWare server name
Define additional properties
Create another NetWare server

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Identification
Purpose
This property page lets you provide optional information that can facilitate searching for the NetWare* server. It also 
shows the network address, status, and NetWare version number for the server. 

Options
Name
Other name
Description
Location
Department
Organization
Net address
Status
Version
Accounting

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Server Login
Purpose
This dialog box appears if you need to log in to a server in bindery mode (NetWare* 2 or 3).

Options
Login to server shows the name of the server you are logging in to.
In User name, type the name of the user you will log in as.
In Password, type the password for the user. If no password is required, leave this field blank.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Resource
Purpose
This property page lets you list resources, such as volumes and printers, that this server provides access to. This 
information is optional and is for reference only. 

Options
Resources
Add
Delete
Accounting



Users
Purpose
This property page lets you list the users of the server. This information is optional and is for reference only. 

Options
Users
Add
Delete
Accounting (NetWare* servers only)

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Error Log
Purpose
This property page lets you view the server's error log. You can also clear the error log to free up disk space. 

Options
Error log
Clear Error Log
Accounting



Supported Services
Purpose
This property page lets you list the services, such as file and print, provided by this server. This information is optional
and is for reference only. 

Options
Supported services
Add
Delete
Accounting



Create AFP Server
Purpose
This dialog box lets you create new AFP Server objects.

Options
AFP server name
Define additional properties
Create another AFP server



Identification
Purpose
This property page lets you provide optional information that can facilitate searching for the AFP Server object. 

Options
Name
Other name
Description
Location
Department
Organization
Version
Serial number
Connections



Create Volume
Purpose
This dialog box lets you create new Volume objects.

Options
Volume name
Host server
Physical volume
Define additional properties
Create another volume



Identification
Purpose
This property page lets you provide optional information that can facilitate searching for the Volume object. It also 
shows the NetWare* server, NetWare version number, and physical volume for the volume. 

Options
Name
Host server
Version
Host volume
Other name
Location
Department
Organization

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Dates and Times
Purpose
This property page shows the date and time the volume was created and last archived (backed up). It also shows and
lets you change who owns the volume and who last archived it. 

Options
Created on
Owner
Modified last on
Archived last on
Archived last by



Statistics
Purpose
This property page shows statistical information about the volume, such as its block size and how much space is 
used. If you are viewing a bindery (NetWare* 2 or 3) volume, the last three fields listed below don't appear. 

Options
[Non-]Removable Volume
Block size
Disk space
Directory entries
Deleted files
Name spaces
Compressed files
Installed features
Migrated files

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



User Space Limits
Purpose
This property page lets you limit the amount of disk space each user can use on the volume. This is optional, but it 
can be helpful if storage resources are limited. 

Options
User space limit list
Modify



User Space Limits
Purpose
This property page lets you limit the amount of disk space each user can use on the volume. This is optional, but it 
can be helpful if storage resources are limited. 
Tip: No user space restrictions are listed until you specify the context of the User objects you want listed (choose the 
browse button next to Search context).
Options

Search context
Search entire subtree
User space limit list
Modify



Volume Space Restriction
Purpose
This dialog box lets you change the space limit for the user.

Options
User
Volume space used by user
Limited volume space
Volume space limit





Create Group
Purpose
This dialog box lets you create Group objects. 

Options
Group name
Define additional properties
Create another group



Identification
Purpose
This property page lets you provide optional information that can facilitate searching for this Group object. 

Options
Name
Other name
Owner
Description
Location
Department
Organization



Members
Purpose
This property page lets you assign users as members of this group. 

Options
Group members
Add
Delete



Create Organizational Role
Purpose
This dialog box lets you create Organizational Role objects. 

Options
Organizational role name
Define additional properties
Create another organizational role



Identification
Purpose
This property page lets you specify the occupants of this Organizational Role object. You can also provide optional 
information that can facilitate searching for the Organizational Role. 

Options
Name
Other name
Occupant
Description
Location
Department
Telephone
Fax number



Set Password for New User
Purpose
This dialog box lets you set the initial login password for the user.

Steps
1. In Password, type the new password.
2. In Retype password, type the new password again.
3. Choose OK.



Password Restrictions
Purpose
This property page lets you set properties related to login password security for the selected users. Any settings you 
make replace the existing settings for the users. 

Options
Allow user to change password 

Require a password
Minimum password length
Force periodic password changes
Days between forced changes
Date password expires
Require unique passwords
Limit grace logins
Grace logins allowed
Set password after create



Password Restrictions
Purpose
This property page lets you implement login password security for this user. 

Options
Allow user to change password
Require a password
Minimum password length
Force periodic password changes
Days between forced changes
Date password expires
Require unique passwords
Limit grace logins
Grace logins allowed
Change Password



Change Password
Purpose
This dialog box lets you change the login password for the user. If the user doesn't have a login password, you can 
set one. The change takes place immediately and cannot be undone.

Steps
1. (Conditional) In Old password, type the current login password.

If the user doesn't currently have a password, this field is disabled.
2. In New password, type the new login password.
3. In Retype new password, type the new password again.
4. Choose OK.



Login Time Restrictions
Purpose
This property page lets you restrict the times when the user can be logged in. 

Options
Time grid 

Reset



Login Time Restrictions
Purpose
This property page lets you restrict the times when the selected users can be logged in. 

Options
Time grid 

Clear all login time restrictions 



Security Equal To
Purpose
This property page lets you assign security equivalences to the user. 

Options
Security equal to 

Add
Delete



Operator
Purpose
This property page lets you list the operators for this server or computer. 

Options
Operators
Add
Delete
Accounting (NetWare* servers only)

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Network Address Restrictions
Purpose
This property page lets you list the network addresses that the user can log in from. 

Options
Network address restrictions 

Network protocol 
Add
Delete



IPX/SPX
Purpose
This dialog box lets you specify an IPX/SPX* address. If you are specifying the address for a printer, you can fill in 
both fields with all F's to indicate that any IPX/SPX address is valid.

Options
In Network, type the cable segment number in hexadecimal (digits 0-9, letters A-F).
In Node, type the network board number in hexadecimal (digits 0-9, letters A-F).

For Ethernet boards, the number is set at the factory. For token ring and ARCNet** boards, the number is set 
using jumpers on the board.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



OSI
This dialog box lets you specify an Open Systems Interconnect address. Type the address in hexadecimal (digits 0-9,
letters A-F). For more information, see your hardware documentation.



SDLC
This dialog box lets you specify a Synchronous Data Link Control address. Enter a hexadecimal value (digits 0-9, 
letters A-F) in each field. For more information, see your hardware documentation.



TCP/IP
This dialog box lets you specify an Internet Protocol address. Enter a decimal number from 0 to 255 in each field.
The left half of the address specifies the network segment. The right half specifies the computer. For more 
information, see your hardware documentation.



AppleTalk
This dialog box lets you specify an AppleTalk** address. Enter a decimal number in the first three fields, and a 
hexadecimal number (digits 0-9, letters A-F) in the last field. For more information, see your hardware documentation.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Ethernet/Tokenring
This dialog box lets you specify an Ethernet or token ring address. Enter a hexadecimal number (digits 0-9, letters A-
F) in each field. For more information, see your hardware documentation.



Network Address
Purpose
This property page lets you list the network addresses for this computer or AFP server. The addresses enable 
NetWare Directory Services* to locate the physical object. 

Options
Network address list
Network protocol
Add
Delete

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Intruder Lockout
Purpose
This property page lets you work with this user's account if it has been locked due to intruder detection.
If the user can't log in, look at Account locked on this page. If it is unchecked, the login problem is caused by 
something else. 

Options
Account locked
Incorrect login count
Account reset time
Last intruder address



Intruder Detection
Purpose
This property page lets you specify how intruders are detected and handled for the user accounts in this container. 

Options
Detect intruders
Incorrect login attempts
Intruder attempt reset interval
Lock account after detection
Intruder lockout reset interval



Search Context
Purpose
This dialog box lets you choose the contexts to search for objects associated with this object's explicit rights 
assignments.

Options
Begin search in context
Search entire subtree



Rights to Other Objects
Purpose
This dialog box lists the explicit object rights and property rights assignments for the selected object. You can make 
additional assignments and view the object's effective rights to objects. 

Options
Assigned objects
Effective Rights
Add Assignment
Delete Assignment
Object rights
Property rights
Clear



Rights to Other Objects
Purpose
This property page lets you make explicit object rights and property rights assignments for the users, including rights 
assignments to self. 

Options
Object list 

Add Assignment
Delete Assignment
Object rights
Property rights
Clear



Effective Rights
Purpose
This dialog box lets you view this object's effective rights to the specified object. You can specify a different target 
object if you want.

Options
Object name
Object rights
Property rights



Effective Rights
Purpose
This dialog box lets you view this user's effective rights to the specified file or directory. You can specify a different 
target file or directory if you want.

Options
File/Directory
File system rights list



Effective Rights
Purpose
This dialog box lets you view the selected trustee's effective rights to this container. You can choose a different object 
to view effective rights for.

Options
Object name
Object rights
Property rights



Effective Rights
Purpose
This dialog box lets you view the selected trustee's effective rights to this object. You can choose a different object to 
view effective rights for.

Options
Object name
Object rights
Property rights



Effective Rights
Purpose
This dialog box lets you view the selected trustee's effective rights to this file or directory. You can choose a different 
object to view effective rights for.

Options
Trustee
File system rights list



Rights to Files and Directories
Purpose
This property page lets you make explicit file system rights assignments for this object. You can also view the object's
effective rights to files and directories. 

Options
Volumes 

Find
Show
Hide
Files and directories
Add
Delete
Path
Rights
Effective Rights



Rights to Files and Directories
Purpose
This property page lets you make explicit file system rights assignments for the users. 

Options
Files and directories 

Add
Delete
Path
Rights
Effective Rights



Trustees
Purpose
This dialog box lets you assign trustees and their explicit object rights and property rights to this object. 
Note: If you are viewing Details, this screen appears as a property page, and doesn't include the Effective Rights 
button. 

Options
Trustee list 

Effective Rights
Add Trustee
Delete Trustee
Object rights
Property rights
Clear
Inherited Rights Filter



Trustees
Purpose
This dialog box lets you assign trustees and their explicit object rights and property rights to this container. 

Options
Trustees 

Effective Rights
Add Trustee
Delete Trustee
Object rights
Property rights
Clear
Inherited Rights Filter



Trustees of this File/Directory
Purpose
This property page lets you assign trustees and their explicit rights to this file or directory. 

Options
Trustees 

Effective Rights
Add Trustee
Delete Trustee
Access rights
Inheritance filter



Trustees of this File/Directory
Purpose
This dialog box lets you assign trustees and their explicit rights to the selected file or directory. 

Options
Trustees
Effective Rights
Add Trustee
Delete Trustee
Access rights
Inheritance filter



Inherited Rights Filter
Purpose
This dialog box lets you edit the Inherited Rights Filter for this container.
To filter (block) an inherited right, uncheck the corresponding check box. If a check box is unavailable, you don't have 
rights to filter the right.

Options
Object rights
Property rights



Inherited Rights Filter
Purpose
This dialog box lets you edit the Inherited Rights Filter for this object. If you are editing the filter on multiple existing 
User objects and you make any changes, the entire filter is replaced for each User.
To filter (block) an inherited right, uncheck the corresponding check box. If a check box is unavailable, you don't have 
rights to filter the right.

Options
Object rights
Property rights



NetWare Registry Editor
Purpose
This property page lets you edit the preferences that are stored for this user in the NRD Registry Index and NRD 
Registry Data properties. This is similar to editing your local Windows** registry. 

Add a preference setting
1. Under Key, choose Add.
2. In the dialog box, type the name for the setting, and then choose OK.

For example: Snapin Object DLLs WIN95

Add a preference setting value
1. From Key, choose the setting, and then under Values, choose Add.
2. In Value name, type the name of the value.

For example: NDSMGR
3. Under Type, choose the type of value; for example, String.
4. In Value, type the value for the setting, and then choose OK.

For example: NMSNAP32.DLL
For some preferences, such as Snapin Object DLLs, you can add multiple values.

Change a preference setting
1. From Key, choose the setting.
2. From Values, choose the value you want to edit, and then choose Edit.
3. In Value, type the new value, and then choose OK.

To change the value name or type, you must add a new value.

Delete a preference setting
From Key, choose the setting, and then choose Delete.

Delete a single value from a setting
1. From Key, choose the setting.
2. From Values, choose the value you want to delete, and then choose Delete.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



NFS Extended Directory Information
Purpose
This property page lists Network File System (UNIX**) information for this directory. 

Options
UID name
UID
GID name
GID
Mode
Number of links
Name
Symbolic links

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



NFS Extended File Information
Purpose
This property page lists Network File System (UNIX**) information for this file. 

Options
UID name
UID
GID name
GID
Mode
Number of links
Name
Symbolic links

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Create Directory Map
Purpose
This dialog box lets you create new Directory Map objects.

Options
Directory map name
Volume
Path
Define additional properties
Create another directory map



Identification
Purpose
This property page lets you provide optional information that can facilitate searching for this Directory Map object. You
can also edit the path that the Directory Map points to. 

Options
Name
Other name
Volume
Path
Description
Location
Department
Organization



Create Directory
Purpose
This dialog box lets you create new directories in the NetWare* file system.

Options
Directory name
Define additional properties
Create another directory

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Identification
This property page lists the names of this directory in each name space that is supported by the volume. You can't 
edit this information. 



Identification
This property page shows the name of this file or directory. To change it, type a new name in New name. 



Facts
Purpose
This property page shows statistics for this directory, such as its creation date and owner. You can edit most fields. 

Options
KB available to directory
Restrict size
Created
Owner
Last modified
Last archived
Archiver



Directory Attributes
Purpose
This property page lets you edit the attributes for this directory. If you chose a volume, the attributes are for the root 
directory of the volume. 

Attributes
Delete Inhibit
Hidden
Purge
Rename Inhibit
System
Don't Migrate
Immediate Compress
Don't Compress



File Attributes
Purpose
This property page lets you edit the attributes for this directory. If you chose a volume, the attributes are for the root 
directory of the volume. 

Attributes
Delete Inhibit
Hidden
Purge
Rename Inhibit
System



Identification
This property page lists the names of this file in each name space that is supported by the volume. You can't edit this 
information. 



Facts
Purpose
This property page shows statistics for this file, such as its creation date and owner. You can edit most fields. 

Options
Size
Created
Owner
Last modified
Modifier
Last accessed
Last archived
Archiver



File Attributes
Purpose
This property page lets you edit the attributes for this file. You can also view its status flags. 

Attributes
Archive Needed
Execute Only
Read Only
Shareable
Hidden
System
Transactional
Purge Immediate
Delete Inhibit
Rename Inhibit
Don't Migrate
Immediate Compress
Don't Compress
Don't Suballocate

Status Flags
File Compressed
Can't Compress
File Migrated



Attributes
Purpose
This property page lets you edit the attributes for this file. 

Attributes
Archive Needed
Execute Only
Read Only
Shareable
Hidden
System
Transactional
Purge Immediate
Delete Inhibit
Rename Inhibit



Salvage Files
Purpose
This dialog box lets you salvage and purge deleted files. Purge files periodically to free up disk space. 

Options
Include
List
Sort options
Source
Deleted file list



File Already Exists
Purpose
This dialog box appears if the file you are salvaging already exists in the directory. In other words, after the file was 
deleted, a new file by the same name was created in the directory.

Options
In New file name, enter a different filename if you still want to salvage the file.
Choose OK to salvage the file under the new name.
Choose Cancel if you don't want to salvage the file.



Move/Copy
Purpose
This dialog box lets you move or copy the selected files and directories. You need the Create right to the destination 
directory.

Options
From
Destination



Move
Purpose
This dialog box lets you move the selected objects. You need the Create right to the destination container.

Options
From
Destination



Rename
Purpose
This dialog box lets you rename the selected object, if you have the Rename right to the object.

Options
New name
Save old name
Create alias in place of renamed container



Objects No Longer Found
Purpose
This dialog box appears if one or more of the selected objects are no longer available. The objects might have been 
deleted, moved, or renamed by another user.

Options
Choose Continue to continue the operation with the remaining available objects.

If none of the selected objects are available, this button is disabled.
Choose Cancel to cancel the operation.

When you return to the browser, you can collapse and reexpand the container to refresh the view and see which 
objects are still available.

Choose Copy List to copy the list of unavailable objects to the clipboard, so you can paste them into a 
document.

Choose Print List to display the Print dialog box, so you can print the list of unavailable objects.



Save As
This dialog box lets you save the current search criteria as a quick search template (.SCH file) so you can reuse them
later. 



Open
This dialog box lets you open a quick search template (.SCH file). When you open a quick search template, the fields 
of the Search dialog box are filled in with the values from the quick search template. 



Search
Purpose
This dialog box lets you search for objects that have specific property values.
The search results are displayed in a new browser window. You can work in the new window just as you do in any 
other browser window.

Options
Start from
Search entire subtree
Search for
Property
Save
Open



Set Context
Purpose
This dialog box lets you choose the tree and context to view in the browser window.

Options
Tree
Context



Select Tree
Purpose
This dialog box lets you choose a tree in your network.

Steps
1. In Tree, type the name of the tree you want, or choose a tree from the list.
2. Choose OK.



Bindery User and Group
This dialog box lets you choose a bindery (NetWare* 2 or 3) user or group from those available on the server. Choose
the user or group, and then choose OK.
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Create Country
Purpose
This dialog box lets you create Country objects.

Options
Country name
Define additional properties
Create another country



Identification
Purpose
This property page shows the name of the Country object, and lets you provide a description for it. 

Options
Name
Description



Create Organization
Purpose
This dialog box lets you create Organization objects. 

Options
Organization name
Define additional properties
Create another organization



Identification
Purpose
This property page lets you provide optional information that can facilitate searching for this Organization object. 

Options
Name
Other name
Description
Location
Telephone
Fax number



Create Organizational Unit
Purpose
This dialog box lets you create Organizational Unit objects. 

Options
Organizational unit name
Define additional properties
Create another organizational unit



Identification
Purpose
This property page lets you provide optional information that can facilitate searching for this Organizational Unit 
object. 

Options
Name
Other name
Description
Location
Telephone
Fax number



Create Computer
Purpose
This dialog box lets you create Computer objects. 

Options
Computer name
Define additional properties
Create another computer



Identification
Purpose
This property page lets you provide optional information that can facilitate searching for this Computer object. 

Options
Name
Other name
Owner
Description
Serial number
Location
Department
Organization
Server



Create Alias
Purpose
This dialog box lets you create Alias objects. 

Options
Alias name
Aliased object
Create another alias



Identification
The only information stored in an Alias object is the name of the object that the Alias refers to.
You can't change property values for an Alias after it has been created. You must delete the Alias and 
create it again if you need to make changes.



Print Setup
This dialog box lets you choose your printer setup. 



Print
Purpose
This dialog box lets you print the current browser window.

Options
Printer shows the printer the job will be sent to. To change it, choose Setup.
Check Print in two columns to format the printout into two columns. To print in one column, uncheck this 

check box.
Check Print to file to save the output as a printer-destined (.PRN) file. You can print the file later by copying 

it to a printer port or dragging it onto a printer icon.
In Print quality, choose the printing quality (density) you want.



Select Object
Purpose
This dialog box lets you choose objects of the appropriate class from the current tree.

Options
Available objects
Browse context
Change Context



Select Object
Purpose
This dialog box lets you choose an object of the appropriate class from the current tree.

Options
Available objects
Browse context
Change Context



Change Context
Purpose
This dialog box lets you choose a container or volume that you don't have the Browse right to. You must have the 
Browse right to a subordinate object, file, or directory.

Steps
1. Type the complete name of the container or volume you want.
2. Choose OK.



Browse Connection
Purpose
This dialog box lists the internet sites you can connect to from NetWare* Administrator.

Options
The list of internet sites shows the sites that you have defined bookmarks for in your internet browser.

You cannot edit the list directly. To add or delete entries, add or delete the bookmarks in your internet browser.
The Connect drop-down list displays the address for the site you will connect to.

Choose an address from the drop-down list, or type in the address you want. Use the syntax required by your 
internet browser.

The Connect button starts your internet browser (if it isn't already running) and connects you to the 
specified internet site.

The Providers button lets you choose the internet browser to use for connecting to the internet.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Service Settings
Purpose
This dialog box lets you choose the internet browser to use for connecting to the internet. You can also specify the 
internet address prefix to be used when connecting to internet sites.

Options
In Service Prefix, type or choose the internet address prefix to be used when connecting to internet sites. 

For example: HTTP:
Under Connect Using, choose the internet browser you want.
Choose Select to select the specified prefix and browser and return to the Browse Connection dialog box.

For the new prefix and browser to be used, the browser must be registered in the Windows** 95** registry.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Quick Connect
No help is available for this screen.





Related Topics
Create Containers, Aliases, and Computers
Browse Objects and Properties
Find, Move, and Rename Objects



Related Topics
New Features
Feature Quick Reference



Related Topics
Create Servers, Volumes, Directories, and Directory Maps
Manage Files and Directories



Related Topics
Getting Started
Organizing and Browsing the Network
Managing User Accounts
Implementing Security
Managing File Services
Configuring Queue-Based Print Services
Setting Preferences
Feature Quick Reference



Related Topics
Filter and Reorder Browser Views
Configure the Toolbar and Status Bar
Install and Remove Tools
Set Other Preferences
Register Preferences



Related Topics
Setting Preferences



Related Topics
Setting Preferences



Related Topics
Setting Preferences



Related Topics
Property Syntax Quick Reference



Related Topics
Setting Preferences
Toolbar - Main Features
Toolbar - View Features
Toolbar Location



Related Topics
Setting Preferences
Toolbar - Main Features
Toolbar Location
Status Bar



Related Topics
Setting Preferences
Toolbar - Main Features
Toolbar - View Features
Status Bar



Related Topics
Setting Preferences
Toolbar - View Features
Toolbar Location
Status Bar



Related Topics
Managing User Accounts
For information on login script commands and variables, see Chapter 3 in Supervising the Network.



Related Topics
Object Class Quick Reference
Install and Remove Object Classes



Related Topics
Managing User Accounts



Related Topics
Managing User Accounts
Object Naming Conventions



Related Topics
Create Templates, Users, and Profiles
Set Up Account Resources
Work with Login Scripts
Edit Multiple Users Simultaneously



Related Topics
Implementing Security



Related Topics
Create Groups and Roles
Assign Rights
Implement Login Security
Set File System Attributes



Related Topics
Implementing Security
Object Naming Conventions



Related Topics
Implementing Security
Object Rights
Property Rights
File System Rights
Properties Quick Reference



Related Topics
Implementing Security
File Attributes
Directory Attributes



Related Topics
Managing File Services



Related Topics
Managing File Services
Object Naming Conventions



Related Topics
Organizing and Browsing the Network



Related Topics
Organizing and Browsing the Network
Filter and Reorder Browser Views



Related Topics
Organizing and Browsing the Network
Object Naming Conventions



Related Topics
Organizing and Browsing the Network
Object and Property Quick Reference



Relate Topics
Quick Setup
Create Print Servers, Printers, and Queues
Manage Print Servers
Manage Printers
Manage Queues
Define Print Devices, Job Configurations, and Forms



Related Topics
Manage Print Servers



Related Topics
Manage Printers



Related Topics
Create Print Servers, Printers, and Queues



Related Topics
Create Print Servers, Printers, and Queues



Related Topics
Create Print Servers, Printers, and Queues



Related Topics
Manage Printers
Manage Print Servers
Create Print Servers, Printers, and Queues



Related Topics
Manage Printers
Manage Print Queues



Related Topics
Manage Print Queues
Manage Print Servers



Related Topics
Manage Print Queues



Related Topics
Create Print Servers, Printers, and Queues
Define Print Devices, Job Configurations, and Forms



Related Topics
Create Print Servers, Printers, and Queues



Related Topics
Create Print Servers, Printers, and Queues



Related Topics
Create Print Servers, Printers, and Queues



Related Topics
Manage Print Servers



Related Topics
Create Print Servers, Printers, and Queues
Manage Print Servers



Related Topics
Manage Print Servers



Related Topics
Create Print Servers, Printers, and Queues



Related Topics
Create Print Servers, Printers, and Queues
Manage Print Queues



Related Topics
Manage Printers



Related Topics
Define Print Devices, Job Configurations, and Forms



Related Topics
Create Print Servers, Printers, and Queues
Manage Printers



Related Topics
Create Print Servers, Printers, and Queues
Manage Printers



Related Topics
Manage Printers



Related Topics
Create Print Servers, Printers, and Queues



Related Topics
Print Services Quick Setup



Related Topics
Manage Print Servers



Related Topics
Manage Print Queues



Related Topics
Manage Print Servers



Related Topics
Define Print Devices, Job Configurations, and Forms



Related Topics
Configuring Queue-Based Print Services



Related Topics
Create Print Servers, Printers, and Queues
Manage Printers





Interrupt Method
Overview
Interrupt method refers to how the printer interrupts the processor of the computer that the printer port driver is loaded
on.

Use Interrupts
Specifies that a specific interrupt number is to be used. If you choose this option, choose an interrupt number in 
Interrupt. Consult the documentation for your parallel or serial ports to find out which interrupt to use.
The interrupt generally must not be used by any other hardware. Some ports might not exist in the workstation, or 
might not have active interrupts, being accessed instead by some polling method.
NetWare* print services supports the use of interrupts 3, 4, 5, 7, 10, and 11. These interrupts correspond to the IRQ 
(interrupt request) levels.
Parallel printer ports generally use the following interrupts: 
LPT1: interrupt 7
LPT2: interrupt 5
LPT3: interrupt 5
COM1: interrupt 4
COM2: interrupt 3
COM3: interrupt 3
COM4: interrupt 3
Serial printer ports generally use the following interrupts:
COM1: Interrupt 4
COM2: Interrupt 3
COM3: Interrupt 3
COM4: Interrupt 3

Polled (This is the default in NetWare 4*)
Specifies that polled mode is to be used. In polled mode, the computer uses the timer interrupt instead of a specific 
interrupt number to gauge signals to the printer.
For most situations, polled mode provides satisfactory performance and avoids the possibility of interrupt conflicts.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Connection Type
Overview
The connection type refers to how the port driver (NPRINTER.EXE/NLM) for the printer is loaded.
Only printers cabled to a NetWare* server that loads the print server (PSERVER.NLM) can have the port driver 
(NPRINTER.NLM) loaded automatically.
Each NPRINTER.NLM loaded on a NetWare server displays a status screen on the NetWare server console.

Manual Load
Indicates that the port driver is manually loaded.
You can choose this option for a printer cabled to any computer on your network. If the printer is cabled to a 
workstation, you must load NPRINTER.EXE from the command line or the AUTOEXEC.BAT file. If the printer is 
cabled to a NetWare server, you must load NPRINTER.NLM from the NetWare server console or the 
AUTOEXEC.NCF file.

Auto Load (This is the default)
Indicates that the port driver is automatically loaded. You can choose this option only for printers cabled to a NetWare
server running PSERVER.NLM. With this option, NPRINTER.NLM is automatically loaded by PSERVER.NLM when 
you load PSERVER.NLM.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Line Control
Overview
Line control defines the parameters for serial printer communication.

Baud Rate
Specifies the speed at which data is transferred over a serial interface. The most common baud rates for printers are 
9600, 1200, and 300 baud. Consult your printer documentation to determine the correct baud rate.

Data Bits
Specify the character length in bits (the number of bits used to represent a character in a character set). The use of 5 
data bits allows 1 or 1.5 stop bits. The use of 6, 7, or 8 data bits allows 1 or 2 stop bits.

Stop Bits
These are special signals in asynchronous communication that specify the minimum length of time between character
transmissions. The time is needed by the receiving circuitry to prepare to receive a new character. 

Parity
Specifies the error-checking method for data transmission. 

None specifies that no parity checking is to be done (this is the default).
Even enables Even parity checking.
Odd enables Odd parity checking.



UNIX Communication
Purpose
This dialog box lets you configure the printer for UNIX**. This type of communication enables native NetWare* users 
to send print jobs to printers on the UNIX network, and UNIX users to send print jobs to printers on the native 
NetWare network.
You must have the print driver LPR_GWY.NLM loaded on your NetWare server and be using the NetWare 4.1 version
of PSERVER and PCONSOLE or NetWare Administrator.

Host Name
Specifies the host of this printer within UNIX.

Printer Name
Specifies the name of this printer within UNIX.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Parallel Communication
Purpose
This dialog box lets you configure parallel communications for the printer. Use this communication type if the printer is
cabled to a parallel port of a workstation or server.

Port
Specifies which hardware parallel port the printer is using. Choose LPT1, LPT2, or LPT3.

Interrupts
Specifies the interrupt method used by the printer.

Connection Type
Specifies the connection type for the printer.



Serial Communication
Purpose
This dialog box lets you configure the printer for serial communication. Use this communication type if the printer is 
cabled to a serial port of a workstation or NetWare* server.

Port
Specifies which hardware serial port the printer is using. Possible values are COM1, COM2, COM3, and COM4.

Interrupts
Specifies the interrupt method used by the printer.

Connection Type
Specifies the connection type for the printer.

Line Control
Specifies line control parameters.

XON/XOFF 
Check this check box to use XON/XOFF. With XON/XOFF, the NetWare port driver expects the printer to send an 
XOFF character (<Ctrl>+<S>) when transmission should be suspended, and an XON character (<Ctrl>+<Q>) when 
transmission can be resumed.
Uncheck this check box to not use XON/XOFF. The NetWare port driver expects the printer to signal its ability to 
receive data by the state of the Clear to Send signal on the serial connection.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



AIO Communication
Purpose
This dialog box lets you configure the printer for asynchronous input/output (AIO). Use this 
communication type if the printer is cabled to an AIO board, which enables a workstation or 
server to support more than seven printers.
Port
Specifies the port number that the printer is connected to. The value must be a number from 0 to 255.

Hardware Type
Specifies the type of hardware being addressed. The allowable range is 0 through 255. Novell* Labs* has designated
the following AIO hardware types:
0 Reserved
1 Comx
2 IBM** Artic
3 Gateway Communications WNIM+**
4-99 Reserved
100 Unused
101 AVM ISDN Controller-B1
102 Newport Systems ANIC
103 Newport Systems WNIC
104 Hayes** Microcomputer Products ESP
105 DIGIXI Digiboard PC/Xe, PC/Xi and MC/Xi series
106 DIGICX Digiboard C/X multichannel cluster controllers
107 DIGIXM Digiboard PC/Xm and PC/Xem
108 DOGIEP Digiboard EPC/X system
109 Network Products Corporation NPCC
110 Unused

Board Number
Specifies the number that is coded into the AIO board that the printer is using. The allowable range is 0 through 255.

Connection Type
Specifies the connection type for the printer.

Line Control
Specifies line control parameters.

Use X-On/X-Off
Check this check box to use XON/XOFF. With XON/XOFF, the NetWare port driver expects the printer to send an 
XOFF character (<Ctrl>+<S>) when transmission should be suspended, and an XON character (<Ctrl>+<Q>) when 
transmission can be resumed.
Uncheck this check box to not use XON/XOFF. The NetWare port driver expects the printer to signal its ability to 
receive data by the state of the Clear to Send signal on the serial connection.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



AppleTalk Communication
Purpose
This dialog box lets you configure the printer for AppleTalk** communication. Use this communication type if the 
printer is cabled to an AppleTalk network. For more information, see Print Services.

Name
Specifies the name of this printer as it is known in the Macintosh** system.

Type
Specifies which type of printer this is. Macintosh compatible printers are listed in the drop-down list.

Zone
Specifies the AppleTalk zone that the printer resides in. The zone is a name that is assigned to a group of computers 
and printers.

Print Error Messages
Specifies whether the printer prints error messages on a banner page.

Hide Printer
Indicates whether the printer is hidden from AppleTalk users. Hide the printer if you want to prevent Macintosh users 
from submitting their print jobs directly to the printer, which can cause conflicts with NetWare* print jobs.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Auditing Log
Purpose
The auditing log is an ASCII text file created by the print server that logs information about all print jobs. The auditing 
log is created only if you enable auditing and then reload the print server.
The auditing log records whatever information a printer sends to it. Regardless of printer type, the log records how 
many bytes a job took to print, the user who submitted the job, when the job entered the print queue, when the job 
was printed, and what printer serviced the job.
If the printer is an XNP type used by Macintosh** or UNIX**, the log might also indicate how long it took to print the 
job, how many pages were printed, when the job was printed, and when the job was submitted. 

Status
Indicates whether auditing is enabled.

Location of Auditing Log
Specifies the path to the log file. It is not configurable.

Current Size
Shows the current size of the file.

Limit Size
To limit the size of the log file, check this check box and use the up and down arrows next to Maximum print jobs to 
set the limit. When the size limit is reached, no more information is logged.
Limiting the size in this way prevents the log from using up too much disk space, but you risk losing valuable auditing 
information if the size limit is exceeded. You might want instead to monitor the log regularly and use Delete to remove
it when it gets too big.

Enable/Disable Auditing
Enables or disables the auditing log.

View
Displays the auditing log, or refreshes your view of it.

Delete
Removes the selected entries from the auditing log. You can choose several entries by holding down Ctrl or Shift 
while clicking.
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Change Printer Number
This dialog box lets you change the ID number assigned to the selected printer. This is the number you specify when 
loading a port driver for the printer in NPRINTER. You must reload the print server for the change to take effect.



Change Password
This dialog box lets you change the print server password. Do this regularly to prevent unauthorized access to the 
print server.
Type the old password followed by the new password twice, and then choose OK.



Create Print Queue
Purpose
This dialog box lets you create Print Queue objects.
NetWare* Print Services requires this object along with a Printer and Print Server object in order for network users to 
share printers.

Directory Services Queue
Lets you create both a Print Queue in your tree and a physical directory for the print queue on a server.

Reference a Bindery Queue
Lets you create an object for a physical print queue that already exists outside the tree on a NetWare 2, 3, or 4 
server. This enables you to manage printing outside the current tree.

Print Queue Name 
Enter the name of the Print Queue as you want it to be displayed in the tree. Make sure you follow standard object 
naming conventions.

Print Queue Volume (Directory Services Queue only)
Specifies the volume where the physical print queue resides. Type the complete name or choose the browse button 
to choose from the available Volume objects. If the volume you want doesn't exist in the tree, you must create it 
before completing this step.

Server\Queue (Bindery Queue only)
Specifies the physical server and queue that the new object represents. Type in the server and queue names with a 
backslash (\) between them (for example, CORP-SERVER\4SI_Q), or choose the browse button to choose from the 
available servers and queues outside the tree.

Define Additional Properties
Lets you define more information about this Print Queue (such as which printers it services and which users can 
access it) immediately after creating it.    You cannot choose this if you choose Create Another Print Queue.

Create Another Print Queue 
Repeats this dialog box rather than returning to the browser.    You cannot choose this if you choose Define 
Additional Properties.

Create
Creates the new Print Queue.
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Create Print Server
Purpose
This dialog box lets you create Print Server objects.
NetWare* Print Services requires this object along with a Printer and Print Queue object in order for network users to 
share printers.

Print Server Name
Enter the name of the Print Server as you want it to be displayed in the tree and as it will be loaded at the NetWare 
server console. Make sure you follow standard object naming conventions.

Define Additional Properties
Lets you define more information about this print server (such as which printers it services and which users can 
access it) immediately after creating it. You cannot choose this if you choose Create another print server.

Create Another Print Server
Repeats this dialog box rather than returning to the browser.    You cannot choose this if you choose Define 
additional properties.

Create
Creates the new Print Server.
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Create Printer
Purpose
This dialog box lets you create Printer objects.
NetWare* Print Services requires this object along with a Print Server and Print Queue object in order for network 
users to share printers.

Printer Name
Enter the name of the Printer as you want it to be displayed in the tree. Make sure you follow standard object naming 
conventions.

Define Additional Properties
Lets you define more information about this printer (such as which queues service it and which users have access to 
it) immediately after creating it.    You cannot choose this if you choose Create another printer.

Create Another Printer
Repeats this dialog box rather than returning to the browser.    You cannot choose this if you choose Define 
additional properties.

Create
Creates the new Printer.
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Server Login
This dialog box lets you establish a bindery connection to a NetWare* server that is not in the current tree so that you 
can access its print queues. 
Enter the username and password for the server, and then choose OK.
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Manage Print Queues
Purpose
Use this set of procedures to manage print queues. Most printing management tasks are accomplished by managing 
print queues.
The relative priority of the print queues determines the order in which the print server services the jobs waiting in the 
queues.
For print jobs that specify a printer but no queue, the default queue for the printer is used. For example, this occurs 
when the CAPTURE command is used.

Prerequisite
Right-click the Print Queue object that you want to manage, and then choose Details.

Add or delete queue users
1. Choose the Users page.
2. To add users, choose Add, choose the User objects, and then choose OK.
3. To delete users, choose the Users, and then choose Delete.

Add or delete queue operators
1. Choose the Operator page.
2. To add an operator, choose Add, choose the Users, and then choose OK.
3. To delete operators, choose the operators, and then choose Delete.

Change the queue's priority
1. From the browser, right-click the Printer object that the queue is assigned to, choose Details, and then choose 

the Assignments page.
2. From Print queues, choose the Print Queue.
3. In Priority, enter the new priority for the Print Queue.

A priority of 1 is the highest; 10 is the lowest.

Change the default queue for a printer
1. From the browser, right-click the Printer, choose Details, and then choose the Assignments page.
2. In Default Print Queue, choose the new default queue.



Manage Print Servers
Purpose
Use this set of procedures to add or delete print server operators, users, and printer assignments. You can also 
change the print server password and unload the print server.

Prerequisite
Right-click the Print Server object that you want to manage, and then choose Details.

Add or delete print server operators
1. Choose the Operator page.
2. To add operators, choose Add, choose the User objects, and then choose OK.
3. To delete operators, choose the operators, and then choose Delete.

Add or delete print server users
1. Choose the Users page.
2. To add users, choose Add, choose the Users, and then choose OK.
3. To delete users, choose the Users, and then choose Delete.

Add or delete printer assignments
1. Choose the Assignments page.
2. To add assignments, choose Add, choose the Printer objects, and then choose OK.
3. To delete assignments, choose the Printers, and then choose Delete.
You must reload the print server before the changes take effect. Also, at least one Print Queue assignment must exist
for a printer serviced by this print server.

Change the print server password
1. Choose the Identification page.
2. Choose Change Password.
3. In New password, type the new password.

The password is not case sensitive.
4. In Retype new password, type the new password again.
5. Choose OK.
To remove a password without assigning a new one, leave both fields blank and choose OK.

Unload the print server
1. On the Identification page, choose Unload.
2. Choose whether to unload PSERVER.NLM immediately or after the current jobs have been serviced, and then 

choose OK.



Manage Printers
Purpose
Use this set of procedures to add or delete print queue assignments and user notifications for a printer. You can also 
change the printer type or service mode and control the printer's status.

Prerequisite
Right-click the Printer object that you want to manage, and then choose Details.

Add or delete Print Queue assignments
1. Choose the Assignments page.
2. To add assignments, choose Add, choose the Print Queue objects, and then choose OK.
3. To delete assignments, choose the queues, and then choose Delete.

Change the printer type or service mode
1. Choose the Configuration page.
2. In Printer type, choose the printer type.

For printers attached to an OS/2** workstation or directly to the network, choose Other/Unknown. Examples of 
this type are HP IIIsi, Compaq** PageMarq** 20, GENICOM 7170, and Talaris 1794 Printstation.

3. If a dialog box appears for the printer type, check the settings, correct any that are wrong, and then choose OK.
For help with the settings, choose Help.

4. In Service mode for forms, choose the service mode you want.

Add, delete, or modify user notifications
1. Choose the Notification page.
2. To add user notifications, choose Add, choose the containers and/or User objects, and then choose OK.

If you choose a container, the users in the container are notified. Notifications are sent for changes in printer 
status, such as paper outages and jams.

3. To delete user notifications, choose the containers and/or Users, and then choose Delete.
If you delete the (Print job owner) entry, you can add it back by checking Notify print job owner.

4. To modify the timing of notifications for a user, choose the User, and then in First and Next, enter new values.
The values correspond to the number of minutes until the first notification, and the number of minutes between 
any subsequent notifications.

Control printer status
1. Choose the Printer Status page.

This page is available only if you are an operator of a print server that services this printer.
2. To make changes to the printer's status, such as mounting a different form or sending a form feed, choose the 

corresponding button.
For help with the buttons, choose Help. Changes you make are effective immediately.
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Service Mode
Purpose
The service mode determines how the print server handles the mounting of new forms on the printer.

Change Forms as Needed
Sends all print jobs to the printer in the order that they arrive, without considering whether the printer form currently in
use is the same as the printer form needed by the next print job. You may have to change printer forms often.

Minimize Form Changes Across Print Queues
Services print jobs in lower priority queues that use the currently mounted form before requiring you to mount a new 
form for a print job in a higher priority queue.

Minimize Form Changes Within Print Queues
Requires you to mount a new form if the current print job requires it, even if there are print jobs in lower priority 
queues that use the currently mounted form.

Service Only Currently Mounted Forms
Holds all print jobs that require a different printer form than the one currently mounted. In this mode, the printer never 
requests a form change. If no print job requiring the current form is available, nothing is printed.



Mount Printer Form
This dialog box lets you mount a different printer form on the printer. You can also mount printer forms at the server 
console.
Choose the form you want to mount, and then choose OK.



Print Job Configuration
Purpose
This property page lists the available print job configurations for this user or container. You can add new 
configurations or modify existing configurations. Changes take place immediately. 

Print Job Configurations
Lists the available print job configurations, and the object that each configuration was defined in.
If you are viewing a container, only the configurations defined for the container are listed. If you are viewing a User 
object, the configurations defined for the user and for the user's container are listed.

New
Lets you define a new print job configuration.

Modify
Lets you modify the selected print job configuration.

Delete
Deletes the selected print job configuration.

Default
Marks the selected print job configuration as the default. (A printer icon appears next to the default configuration.)



Job Details
Purpose
This dialog box shows details for the selected print job. If you didn't submit the print job, to change any settings you 
must be an operator of the Print Queue.

Print Job
Shows the job ID.

File Size
Shows the file size of the print job in bytes.

Client
Shows the user who submitted the print job.

Description
Shows a description that was entered for the print job.

Status
Shows the status of the print job. The possible states are

Print job is being serviced
Print job has operator hold
Print job is ready and waiting for the print server
Print job is being added to the Print Queue
Print job will be serviced at the target date and time

User Hold
Indicates whether the print job has been put on hold by the user who submitted it.

Operator Hold
Indicates whether the print job has been put on hold by the queue operator.

Service Sequence
Shows the print job's position in line to be serviced.

Number of Copies
Shows how many copies are to be sent to the printer.

File Contents
Shows the type of file that was sent.

Byte Stream
Indicates whether the print job is a byte stream file, such as a graphic or PostScript** file.

Text
Indicates whether the print job is a text file, containing only ASCII characters.

Tab Size
Used only with text files. Sets the number of spaces between tab stops.

Form Feed
Indicates whether a form feed character is sent to the printer at the end of the print job.

Notify When Job is Printed
Indicates whether users are notified when the print job is done.

Entry Date
Shows the date the print job entered the queue.

Entry Time
Shows the time the print job entered the queue.

Form



Specifies which printer form is used to print the job. You can choose a different form.

Print Banner
Indicates whether a banner page is printed for the job.

Name
Identifies the user who sent the print job. This information is available only if Print banner is checked.

Banner Name
Specifies the name of the print job. This information is available only if Print banner is checked.

Defer Printing
Indicates whether the print job is deferred until a later date and time.

Target Date
Shows the date the print job will be printed. This information is available only if Defer printing is checked.

Target Time
Shows the time the print job will be printed. This information is available only if Defer printing is checked.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Job List
Purpose
This property page lists the print jobs that are currently in this Print Queue. Information about each print job is shown 
in the table. Use the scroll bar to view more columns in the table. For jobs that you didn't submit, you must be an 
operator of the Print Queue to change the status of the job. 

Print Queue
Shows the name of this Print Queue object.

Print Jobs
Shows the number of print jobs currently in the queue.

Seq
Shows the order in which jobs will be sent to the printer.

Job Name
Shows the names of the print jobs. If CAPTURE was used, the name is the captured port. If NPRINT was used, the 
name is the filename.

Description
Shows descriptions for the print jobs.

Form
Shows the printer forms specified for the print jobs.

Status
Shows the status of each print job: Ready, Held, Paused, or Printing.

Job ID
Shows the job IDs assigned by NetWare*.

Job Details
Lets you view or change details about the selected print job.

Hold Job
Places a hold on the selected print job. The job won't print until you choose Resume.

Resume
Releases a hold from the selected print job.

Delete
Deletes the selected print job from the queue.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Assignments
Purpose
This property page lists the print servers and printers that are assigned to service this queue. To change these 
assignments, use the Assignments page of the Print Server or Printer object. 

Authorized Print Servers 
Lists the print servers that are assigned to service this queue.

Printers Servicing Print Queue
Lists the printers that are assigned to receive print jobs from this queue.



Identification
Purpose
This property page lists optional information for this Print Queue object, such as additional names and its location. 
The information is for reference only. 

Name
Shows the name of this Print Queue.

Volume
Specifies the volume where the physical queue is located.

Other Name
Lists other names for this Print Queue (such as a name the queue was previously known by).

Description
Provides a description for the Print Queue, such as "Print jobs for the marketing group."

Location
Shows the print queue's physical location (such as a room number).

Department
Shows the department or division that generally uses the print queue.

Organization
Lists the organizations that can use the print queue.

Operator Flags
Allow users to submit print jobs specifies whether users can submit print jobs to the queue.
Allow service by current print servers specifies whether the assigned print servers can service jobs in the

queue.
Allow new print servers to attach specifies whether new print servers can attach to the queue so they can 

service it.



Operator
Purpose
This property page lets you assign operators for this queue. Operators can manage the print jobs in the queue. This 
includes activities such as deleting print jobs or changing their order. 

Operators
Lists the operators of this queue.

Add
Lets you add an operator to the list by browsing the available User objects.

Delete
Deletes the selected operator from the list.



Assignments
Purpose
This property page lets you list the printers to be serviced by this print server. For NetWare* Print Services to work, at 
least one printer must be listed. 

Printers
Lists the printers serviced by this print server.
For each printer, an ID number is also listed. This is the number you specify when loading a port driver for the printer 
in NPRINTER.

Add
Lets you add a printer to the list.

Delete
Removes the selected printer from the list.

Printer Number
Lets you change the ID number for the selected printer. This is the number you specify when loading a port driver for 
the printer in NPRINTER. You must reload the print server for the change to take effect.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Identification
Purpose
This property page lists optional information for this Print Server object, such as additional names and its location. 
The information is for reference only. 

Name
Shows the name of the Print Server.

Advertising Name
Specifies the name used by the print server for network communications.

Other Name
Lists additional names for the Print Server. This information can facilitate searching for the Print Server.

Network Address
Lists the 8 digit IPX internal network addresses of the NetWare* server that this print server (PSERVER.NLM) is 
loaded on.

Description
Provides a description for the print server.

Location
Specifies the print server's physical location, such as a room number.

Department
Specifies the department or division that generally uses the print server.

Organization
Specifies an organization associated with the print server.

Version
Shows the version number of PSERVER.NLM.

Status
Shows the status of the print server (Running, Going Down, or Down).

Unload
Lets you take down the print server. You must be an operator or ADMIN.

Change Password
Lets you set a password to secure the print server. You can also remove the password with this option.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Operator
Purpose
This property page lets you assign operators for this print server. Operators can manage the print server and the 
printers that it services. This includes unloading the print server, viewing its status, and controlling individual printers.

Operators
Lists the operators of this print server.

Add
Lets you add an operator to the list by browsing the available User objects.

Delete
Deletes the selected user from the list.



Print Services Quick Setup
Purpose
This dialog box lets you set up network printers and queues that can be shared by users in the selected container. 
This includes creating a Print Server, Printer, and Print Queue object, and loading the required server and driver 
software.

Prerequisites
The printer is physically connected to the network or a server or workstation on the network.
You are logged in as ADMIN or equivalent.

Steps
1. In Print server name, type a name for the Print Server object, or choose the browse button to choose an existing

Print Server.
For a new Print Server, make sure you follow standard object naming conventions.

2. Under Printer in Name, type a name for the new Printer object.
Make sure you follow standard object naming conventions.

3. In Type, choose the type of communication used by the printer.
If the printer is attached to an OS/2** workstation or directly to the network, choose Other/Unknown. Examples of
this type are HP IIIsi, Compaq** PageMarq** 20, GENICOM 7170, and Talaris 1794 Printstation.

4. If a dialog box appears, check the communication settings and make any needed changes.
For help with the settings, choose Help.

5. Under Print queue in Name, type a name for the new Print Queue object.
Again, make sure you follow standard object naming conventions.

6. In Volume, type the complete name of the volume to create the physical queue on, or choose the browse button 
to choose from the available volumes.

7. Choose Create.
8. At the console of the NetWare server that you want to become the print server, load PSERVER.NLM.

When prompted for the Print Server name, type in the complete name of the object you created in Step 1, or 
press Insert to browse the tree for it.

9. Load the printer driver.
If the printer is attached to the server, the driver (NPRINTER.NLM) is automatically loaded by the print 

server.
If the printer is attached to a DOS workstation, run NPRINTER.EXE on the workstation.
If the printer is attached to a Windows** 95** workstation, run NPTWIN95.EXE on the workstation.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Assignments
Purpose
This property page lets you list the print queues from which jobs can be sent to this printer. It also shows the print 
server that does the sending. 

Print Server
Specifies the print server that sends jobs to this printer.

Print Queues
Lists the queues from which jobs are sent to this printer.
For each queue, a priority number is also listed. In cases where the next job could be taken from more than one 
queue, the priority number determines which queue is serviced first.

Add
Lets you add a queue to the list.

Delete
Removes the selected queue from the list.

Priority
Specifies the priority of the selected queue relative to the other queues in the list. In cases where the next job could 
be taken from more than one queue, the priority number determines which queue is serviced first. Use the up and 
down arrows to set the number.

Default Print Queue
Specifies which queue is used if no queue is specified by the print job. You can choose a different default from the 
drop-down list.



Configuration
Purpose
This property page lets you configure this printer. The default settings are for a parallel printer cabled to the LPT1 port
of a NetWare* server running PSERVER.NLM. 

Printer Type
Specifies the communication method used by this printer (for example, parallel or serial). If the printer is attached to 
an OS/2** workstation or directly to the network, use type Other/Unknown.

Communication
Lets you modify the printer's communications settings.

Banner Type
Specifies the mode in which the printer produces banner pages. For example: text or PostScript**.

Service Interval
Specifies how often the print server checks the print queue for jobs destined for this printer. The default is every 5 
seconds. Values from 1 to 255 are allowed.

Buffer Size in KB
Specifies how large any piece of data sent to this printer can be. The default is 3 KB (3,072 bytes). Values from 3 to 
20 are allowed.

Starting Form
Specifies the number of the printer form used by the printer when the NetWare port driver is loaded. Printer forms are
defined in the parent container for this Printer object. Possible values are from 0 to 255.

Network Address Restrictions
Specifies which network addresses this printer can use.

Set
Lets you set an IPX network address restriction for the printer.

Service Mode for Forms
Specifies the service mode for the printer.
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Features
Purpose
This property page lets you record optional information about this printer's features, such as the supported printer 
languages, the amount of memory installed, and the supported typefaces. This information can facilitate searching for
the Printer object based on features. 

Page Description Language
Specifies the printer languages supported by the printer.

Memory in KB
Specifies the amount of RAM installed in the printer.

Supported Type Faces
Specifies the fonts that the printer can use.

Supported Cartridges 
Specifies the font cartridges that the printer can use.



Printer Forms
Purpose
This property page lets you define printer forms for use by the Printer objects in this container. All changes take effect
immediately. 

Number/Name
Lists the number and name for each available printer form.

Create
Lets you add a form to the list.

Modify
Lets you modify the selected form.

Delete
Lets you delete the selected form.



Notification
Purpose
This property page lets you control who gets notified if the printer requires servicing, such as if it is out of paper or 
jammed, and when and how often the notifications are sent. 

Notify
Lists the users and containers that receive notifications. If a container is listed, all the users in the container receive 
notifications.

First
Specifies the number of minutes until the first notification. To change it for a user or container, choose the User object
or container, and then under Notification settings, enter the value in First.

Next
Specifies the number of minutes between subsequent notifications. To change it for a user or container, choose the 
User object or container, and then under Notification settings, enter the value in Next.

Add
Lets you add a user or container to the list.

Delete
Removes the selected user or container from the list.

Notify Print Job Owner 
Adds an entry for the print job owner to the list, so that whoever sends a job receives notifications.



Identification
Purpose
This property page lists optional information for this Printer object, such as additional names and its location. The 
information is for reference only. 

Other Name
Lists additional names for the Printer. This information can facilitate searching for the Printer.

Network Address
Lists the 8 digit IPX internal network addresses of the NetWare* server or workstation that this Printer is attached to.

Description
Provides a description for the Printer.

Location
Specifies the Printer's physical location, such as a room number.

Department
Specifies the department or division that generally uses the Printer.

Organization
Specifies an organization associated with the Printer.
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Printer Status
Purpose
This property page shows the current status of the Printer. You can change settings only if you are an operator of a 
print server that services this Printer. 

Status
Shows the current status. The possible states are

Not connected
Waiting for form
Out of paper
Printing
Paused
Stopped
Offline
Private
Waiting for job
Ready to go down

Mounted Form
Shows the number of the form currently mounted in the Printer. Only print jobs that specify this Printer form number 
can be printed until a new Printer form is mounted with the Mount Form button.

Service Mode
Shows which service mode is being used by this Printer.

Current Job Information
Includes all the information about the print job currently being printed on this Printer. Some of this information can be 
changed only by going to the print queue and choosing the job from the list of jobs.

Print Queue
Specifies which print queue submitted the print job.

Description
Specifies the banner name of the print job. If NPRINT is used, it is the filename. If CAPTURE is used, it is the port 
that was captured.

Job Number
Specifies the job ID.

Form
Shows which Printer form the job is using. The job cannot be printed unless this matches with the form specified in 
Mounted form.

Copies Requested
Specifies the number of copies requested by the user.

Copies Complete
Indicates how many of those copies have been printed.

Size of 1 Copy
Indicates the size of each copy of this print job. This is like the File size field when you see the details of a print job 
within the print queue.

Bytes Printed
Specifies the total number of bytes sent to the Printer for this job.

Percent Complete
Specifies the number of bytes printed so far for the current copy.

Abort Job
Lets you cancel this print job.



Pause
Changes the status of this print job. Status can be changed from Printing to Paused, or from Waiting for job to 
Stopped. Only a print queue operator can perform this action.

Start
Changes the status of this print job. Status can be changed from Paused to Printing, Stopped to Printing, or 
Stopped to Waiting for job.

Mount Form
Lets you mount a different Printer form on this Printer.

Eject Page
Sends a command to this Printer to eject the page that is being printed. This is like a Form Feed command.



Network Server and Queue
Purpose
This dialog box lets you choose a print queue from outside the current tree so that you can create an object for the 
queue.
You can find queues on any server that you have an account on.

Network Server/Queue
Shows the server and queue that you have chosen.

List Only Attached Servers
To limit the list of servers to those you are currently attached to, check this check box.
To include all the servers in the network, uncheck this check box. If your network is large, building the list can take 
some time.

Network Servers
Lists the available servers outside the current tree. Choose the server that contains the queue you want.

Queues
Lists the queues available on the selected server. Choose the one you want.



Create Print Server, Printer, and Print Queue Objects
Purpose
To set up network printing, you create Print Server, Printer, and Print Queue objects, and then assign them to each 
other. You must also load the required server and driver software.

Create a Print Queue
1. Right-click the container where you want to create the queue, and then choose Create.
2. In Class of new object, choose Print Queue, and then choose OK.
3. If the physical queue already exists outside the current tree, choose Reference a bindery queue. Otherwise, 

leave Directory Services queue selected.
4. In Print queue name, type a name for the new object.

Make sure you follow standard object naming conventions.
5. If you chose Reference a bindery queue in Step 3, in Server\Queue, type the name of the server and physical 

queue, with a backslash (\) between them, or choose the browse button to choose from the available servers and 
physical queues.
If you chose Directory Services queue in Step 3, in Print queue volume, type the complete name of the volume
where you want to create the physical queue, or choose the browse button to choose from the available volumes.
Novell* recommends that you choose the volume that usually has the most free disk space.

6. Choose Create.

Create a Printer
1. Right-click the container where you want to create the Printer, and then choose Create.
2. In Class of new object, choose Printer, and then choose OK.
3. In Printer name, type a name for the new object.

Make sure you follow standard object naming conventions.
4. Choose Create.

Create a Print Server
1. Right-click the container where you want to create the Print Server, and then choose Create.
2. In Class of new object, choose Print Server, and then choose OK.
3. In Print server name, type a name for the new object.

This is the name you will use for the print server at the server console. Make sure you follow standard object 
naming conventions.

4. Choose Create.

Assign the objects to each other
1. Right-click a Printer, choose Details, and then choose the Assignments page.
2. Choose Add, choose the queues you want, and then choose OK.

These are the queues where jobs destined for this printer will be temporarily stored.
3. Choose OK.
4. Right-click a Print Server, choose Details, and then choose the Assignments page.
5. Choose Add, choose the Printers you want, and then choose OK.

These are the printers that will be managed by this print server.

Load print servers and drivers
1. On each NetWare server that you want to become a physical print server, load PSERVER.NLM.

When prompted for the print server name, type in the complete name of the object, or press Insert to browse the 
tree for it.

2. On each server or workstation that a network printer is attached to, load the printer driver.
If the printer is attached to the server, the driver (NPRINTER.NLM) is automatically loaded by the print 

server.
If the printer is attached to a DOS workstation, run NPRINTER.EXE on the workstation.
If the printer is attached to a Windows** 95** workstation, run NPTWIN95.EXE on the workstation.
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Unload Print Server
Purpose
To activate changes in the printing configuration, you must unload and reload PSERVER.NLM. You must be ADMIN 
or an operator of the print server.

Unload Print Server Immediately
Stops printing now and unloads PSERVER.NLM. Other print jobs serviced by this print server are not printed until 
PSERVER.NLM is reloaded.

Unload Print Server After Current Jobs 
Finishes printing the jobs that are currently in the queues serviced by the print server, and then unloads 
PSERVER.NLM. No new print jobs are started until PSERVER.NLM is reloaded.



Users
Purpose
This property page lets you list the users who can submit print jobs to this queue. You must be an operator of the 
queue to edit the list. 

Users
Lists the users and containers that can submit jobs to this queue. If a container is listed, all the users in the container 
can submit jobs to the queue.

Add
Lets you add a user to the list by browsing the available User objects.

Delete
Deletes the selected user from the list.



Users
Purpose
This property page lets you list the users who can view the status of this print server. 

Users
Lists the users and containers that can view the status of this print server. If a container is listed, all the users in the 
container can view the print server status.

Add
Lets you add a user to the list by browsing the available User objects.

Delete
Deletes the selected user from the list.



Print Layout
Purpose
This property page shows a diagram of your printing setup. You can see which objects are assigned to each other 
and each object's status. This information can help you quickly determine whether there are any problems. 
Note: Status on print jobs is not available in this property page. See the property pages for the queue where the job 
is stored.

Print Layout Diagram
Shows the print layout diagram. 

Update
Refreshes the print layout diagram to reflect any changes with the objects.

Status
Provides a status summary for the selected object.





Configuring Queue-Based Print Services
Purpose
Configuring queue-based print services enables users to share network printers. It includes the tasks outlined below.

Initial Setup
To set up the overall printing system, you create Print Server, Printer, and Print Queue objects, and associate them 
with each other. 

Managing the System
To enable the printing system to be monitored and controlled, you assign operators for print servers and queues. The 
operators can manage jobs in the queue, configure the printer notification system, and restart the print server to 
activate configuration changes.

Defining Print Devices, Job Configurations, and Forms
For the users in a container, you can add printer control capabilities not provided by the printing utilities by defining 
print devices. You can also define print job configurations and printer forms to simplify printing tasks.



Define Print Devices, Job Configurations, and Forms
Purpose
For the users in a container, you can add printer control capabilities not provided by the printing utilities by defining 
print devices. You can also define print job configurations and printer forms to simplify printing tasks.

Prerequisite
Right-click the container that contains the users for whom you want to define the services, and then choose 

Details.

Define print devices
1. Choose the Print Devices page.
2. Define the print devices.

To create a device, choose Create, and then complete the dialog box.
To modify a device, from Name, choose the device, choose Modify, and then complete the dialog box.
To delete a device, from Name, choose the device, choose Delete, and then choose OK.
To export a device, from Name, choose the device, choose Export, choose the filename and location, and 

then choose OK. 

By convention, print device files have a .PDF extension.
To import a device, choose Import, choose the .PDF file, and then choose OK. 

.
The .PDF files that are shipped with NetWare* are in SYS:PUBLIC. They define functions for commonly used 
print devices.

Define print job configurations
1. Choose the Print Job Configuration page.
2. Define the print job configurations.

To create a configuration, choose New, and then complete the dialog box.
To modify a configuration, from Print job configurations, choose the configuration, choose Modify, and 

then complete the dialog box.
To delete a configuration, from Print job configurations, choose the configuration, and then choose Delete.
To choose the default configuration for the user or container, from Print job configurations, choose the 

configuration, and then choose Default.
A printer icon appears next to the configuration.

Define printer forms
1. Choose the Printer Forms page.
2. Define the printer forms.

To create a form, choose Create, and then complete the dialog box.
To modify a form, from the form list, choose the form, choose Modify, and then complete the dialog box.
To delete a form, from the form list, choose the form, choose Delete, and then choose OK.

Deletions cannot be undone.
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Create Print Job Configuration
Purpose
This dialog box lets you create a print job configuration.

Steps
1. Choose the options you want.
2. Choose OK.



Modify Print Job Configuration
Purpose
This dialog box lets you modify the selected print job configuration.

Steps
1. Edit the options you want to change.

To change the name of the print job configuration, you must create a new print job configuration.
2. Choose OK.



Print Job Configuration Options
Print Job Name
Specifies the name of the print job configuration. You cannot edit this field for an existing print job configuration. To 
change the name, you must create a new print job configuration.

Number of Copies
Indicates how many copies of the file to print. Possible values are from 1 to 65,000.

File Contents
Specifies the type of file, Byte Stream or Text. With Text, tabs are recognized and the tab size can be set.

Tab Size
Specifies the tab size, in spaces.

Form Feed
To send a form feed when the job is done, check this check box.

Notify When Done
To send a message to the job originator when the job is done, check this check box.

Local Printer
Specifies the parallel port that the job is directed to. Possible values are LPT1 through LPT9.

Auto End Cap
To automatically close the queue file when the job is done, check this check box.

Printer/Queue
Specifies the complete name of the printer or queue used for the job. To choose from the available Printer and Print 
Queue objects, choose the browse button.

Device
Lets you choose a print device for the job.

Mode
Lets you choose a printer mode for the job. Different modes are available for different print devices.

Form Name
Lets you choose a printer form for the job.

Print Banner
To print a banner page at the beginning of the job, check this check box.

Name
If you checked Print banner, type your name as you want it to appear on the banner page. If you leave the field 
blank, your username is used.

Banner Name
If you checked Print banner, type the name of the job as you want it to appear on the banner page. If you leave the 
field blank, the filename appears if you are using NPRINT; the port number appears if you are using CAPTURE.

Enable Timeout
To cause the job to time out after a specified period of time, check this check box and fill in Timeout count.

Timeout Count
If you checked Enable timeout, type the number of seconds the job will take to time out if the printer doesn't 
respond. Possible values are from 1 to 1000 seconds.



Create New Function
Purpose
This dialog box lets you create a printer function.

Steps
1. In Function name, type a name for the function.

Function names must be unique (no two names can be the same) and can be up to 32 characters long. They are 
not case sensitive. You can use both letters and numbers.

2. In Control sequence, type a control sequence.
3. Choose OK.



Create New Mode
Purpose
This dialog box lets you create a printer mode.

Steps
1. In Mode name, type a name for the mode.

Use a name that indicates the purpose of the mode, such as MEMO. The name must begin with a letter and can 
be up to 8 characters long.

2. From Device functions, choose a function to execute for the mode, and then choose Add Below.
3. Repeat Step 2 until you have added, in order, all the functions to be executed for the mode.

You can repeat functions as needed. Use Delete and Add Above to reorder the functions as needed. The 
functions will execute in the order listed.

4. Choose OK.



Create New Device
Purpose
This dialog box lets you create an empty print device. After creating it, use the Modify button on the Print Devices 
property page to create the functions and modes for the print device.

Steps
1. In Name, enter a name for the print device.

The name must start with a letter or number and can be up to 32 characters long. Spaces are allowed.
2. Choose OK.
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Create New Form
Purpose
This dialog box lets you create a printer form.

Steps
1. In Name, type a name for the form.

The name must begin with a letter and can be up to 12 characters long. Spaces are converted to underscores (_).
The name must be unique (no two forms can have the same name).

2. In Number, type a number from 0 to 255.
This is the ID number you use to mount the form.

3. In Length, type a number from 1 to 255.
This is the form's height in lines of text. It is used by the printer's rewind function.

4. In Width, type a number from 1 to 999.
This is the form's width in characters. This information is for reference only (the printer doesn't use it).

5. Choose OK.



Delete Existing Function
This dialog box lets you delete the selected function. All fields are grayed because you cannot change anything; you 
can only see what you are deleting.



Delete Existing Mode
This dialog box lets you delete the selected mode. All fields are grayed because you cannot change anything; you 
can only see what you are deleting.



Delete Existing Device
This dialog box lets you delete the selected print device. All fields are grayed because you cannot change anything; 
you can only see what you are deleting.



Delete Existing Form
This dialog box lets you delete the selected printer form. All fields are grayed because you cannot change anything; 
you can only see what you are deleting.



Modify Existing Function
Purpose
This dialog box lets you modify the selected function.

Steps
1. (Optional) In Function name, edit the function name.

Function names must be unique (no two names can be the same) and can be up to 32 characters long. They are 
not case sensitive. You can use both letters and numbers.

2. (Optional) In Control sequence, edit the control sequence.
3. Choose OK.



Modify Existing Mode
Purpose
This dialog box lets you modify the selected printer mode.

Steps
1. (Optional) In Mode name, edit the mode name.

Use a name that indicates the purpose of the mode, such as MEMO. The name must begin with a letter and can 
be up to 8 characters long.

2. (Optional) Use Add Below, Add Above, and Delete to edit Mode functions.
List all the functions that will execute for the mode, in the order of execution. You can choose from the functions 
listed in Device functions. You can repeat functions as needed.

3. Choose OK.



Modify Existing Form
Purpose
This dialog box lets you modify the selected printer form.

Steps
1. (Optional) In Name, edit the form name.

The name must begin with a letter and can be up to 12 characters long. Spaces are converted to underscores (_).
The name must be unique (no two forms can have the same name).

2. (Optional) In Number, type a number from 0 to 255.
This the ID number you use to mount the form.

3. (Optional) In Length, type a number from 1 to 255.
This is the form's height in lines of text. It is used by the printer's rewind function.

4. (Optional) In Width, type a number from 1 to 999.
This is the form's width in characters. This information is for reference only (the printer doesn't use it).

5. Choose OK.



Print Devices
Purpose
This property page lets you list the print devices that define the supported functions and modes for the Printer objects
in this container. You can import and export print devices to avoid reentering the same information in different 
containers. All changes take effect immediately. 

Name
Lists the available print devices for this container.

Create
Lets you add a print device to the list.

Modify
Lets you add, modify, and remove functions and modes for the selected device.

Delete
Lets you delete the selected device.

Import
Lets you add a device to the list by importing a .PDF file.

Export
Lets you save the selected device as a .PDF file. This option doesn't delete the device from the list.



Modify Existing Device
Purpose
This dialog box lets you modify the selected print device.

Steps
1. (Optional) In Name, modify the device name.
2. Create, modify, and delete the functions and modes you want.

To create a function, choose Create Function, and then complete the dialog box. Create only the functions 
you need for the modes you want.

To modify a function, from Functions, choose the function, choose Modify, and then complete the dialog 
box.

To create a mode, choose Create Mode, and then complete the dialog box.
To modify a mode, from Modes, choose the mode, choose Modify, and then complete the dialog box.
To delete a function or mode, choose it, choose Delete, and then choose OK.

3. Choose OK.



Control Sequence
Purpose
A control sequence (also called a control code or escape sequence) is a sequence of characters that invokes a 
specific printer function. See your printer manual for the control sequences used by your printer.
The following rules apply to control sequences.

ASCII Ranges
Characters with ASCII values from 33 through 126 are not delimited; they display as is. If a character in the control 
sequence has an ASCII value less than 33 or equal to 127, the character is displayed as a delimited token (see 
below). If the character's ASCII value is greater than 127, it is displayed as a delimited ASCII value. The value is a 
decimal number.
The space character can be entered as a space or as a delimited token. A space is displayed as a delimited token. 
Except for delimited tokens, characters in a function follow the "used as is" rule. This means that the characters you 
see displayed are the actual characters that make up the function.

Delimited Tokens
PRINTDEF functions can contain special characters when delimited tokens are included in the function. A delimited 
token has two parts: the delimiters and the token. 
The three delimiters are

Angle brackets < and >
Backslash \
Caret ^

Because these characters function as delimiters, they are exceptions to the "used as is" rule. To enter a left-angle 
bracket (<), backwards slash (\), or caret (^), you must enter two characters. The right-angle bracket (>) can be used 
as is.
For example, a function that contains the string \\<<^^> will be interpreted as \<^>. The double rule is used when 
entering and displaying PRINTDEF functions.
The other part of a delimited token is the token. A token can be a number, a character, or a valid character string.

Numbers
Numbers are used in conjunction with the angle bracket or backslash delimiters and can be entered in decimal or 
hexadecimal. To enter a hexadecimal number, use a 0x or 0X prefix. A number without the hexadecimal prefix is 
assumed to be decimal. 
For example, the ASCII control character can be input by the delimited numbers <27>, <0x1b>, <0X1B>, \27, \0x1b, 
or \0X1B. 
You can enter any ASCII character value from 0 to 255 using this method.

Character Tokens
Character tokens can be used with angle bracket or caret delimiters. Valid characters are A through Z and a through 
z. Delimited character tokens are the same as ASCII control characters. In other words, ^A has an ASCII value of 1, 
^B has an ASCII value of 2, etc.
Character string tokens are the names or acronyms of ASCII control characters. The names are not case sensitive. 
For example, the ASCII control character can be input by the delimited strings <esc>, <ESC>, or <Esc>.
The syntax for a delimited token is any of the following:

delimited_token = delimited_number, delimited_character, or delimited_string
delimited_number = <number_token> or \number_token
delimited_character = ^character_token or <^character_token>
delimited_string = <string_token>
character_token = A - Z or a - z
string_token = <control character name>

String Tokens
Following are the valid string tokens, listed by ASCII value:
0 NUL, NULL
1 SOH, ^A, START OF HEADER, START_OF_HEADER, STARTOFHEADER
2 STX, ^B, START OF TEXT, START_OF_TEXT, STARTOFTEXT
3 ETX, ^C, END OF TEXT, END_OF_TEXT, ENDOFTEXT



4 EOT, ^D, END OF TRANSMISSION, END_OF_TRANSMISSION, ENDOFTRANSMISSION
5 ENQ, ^E, ENQUIRE
6 ACK, ^F, ACKNOWLEDGE
7 BEL, ^G, BELL
8 BS,    ^H, BACK SPACE, BACK_SPACE, BACKSPACE
9 TAB, ^I, HT, HORIZONTAL TAB, HORIZONTAL_TAB, HORIZONTALTAB
10 LF,    ^J, LINE FEED, LINE_FEED, LINEFEED
11 VT,    ^K, VERTICAL TAB, VERTICAL_TAB, VERTICALTAB
12 FF,    ^L, FORM FEED, FORM_FEED, FORMFEED
13 CR,    ^M, RET, CARRIAGE RETURN, CARRIAGE_RETURN, CARRIAGERETURN
14 SO,    ^N, SHIFT OUT, SHIFT_OUT, SHIFTOUT
15 SI,    ^O, SHIFT IN, SHIFT_IN, SHIFTIN
16 DLE, ^P, DATA LINK ESCAPE, DATA_LINK_ESCAPE, DATALINKESCAPE
17 DC1, ^Q, DEVICE CONTROL 1, DEVICE_CONTROL_1, DEVICECONTROL1
18 DC2, ^R, DEVICE CONTROL 2, DEVICE_CONTROL_2, DEVICECONTROL2
19 DC3, ^S, DEVICE CONTROL 3, DEVICE_CONTROL_3, DEVICECONTROL3
20 DC4, ^T, DEVICE CONTROL 4, DEVICE_CONTROL_4, DEVICECONTROL4
21 NAK, ^U, NEGATIVE ACKNOWLEDGE, NEGATIVE_ACKNOWLEDGE, NEGATIVEACKNOWLEDGE
22 SYN, ^V, SYNCHRONOUS
23 ETB, ^W, END OF TRANSMISSION BLOCK, END OF TRANS BLOCK, END_OF_TRANSMISSION_BLOCK, 

ENDOFTRANSMISSIONBLOCK
24 CAN, ^X, CANCEL
25 EM,    ^Y, END OF MEDIUM, END_OF_MEDIUM, ENDOFMEDIUM
26 SUB, ^Z, SUBSTITUTE
27 ESC, ^[, E C, ESCAPE
28 FS,    ^/, FILE SEPARATOR, FILE_SEPARATOR, FILESEPARATOR
29 GS,    ^], GROUP SEPARATOR, GROUP_SEPARATOR, GROUPSEPARATOR
30 RS, RECORD SEPARATOR, RECORD_SEPARATOR, RECORDSEPARATOR
31 US,    ^_, UNIT SEPARATOR, UNIT_SEPARATOR, UTILSEPARATOR
32 SP, SPACE
127 DEL, DELETE

Examples
The following are three equivalent control sequences:

<ESC><SI>^^<DEL><soh> 
<0x1B><0xF>\0x5E<0x7F>^A
\27<15><94><127>\1






